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Cassini 16 Automated Test Equipment tests semiconductors with a modular collection of instruments that 
have very high mean time between failure (MTBF).  Any mechanical or electrical malfunction can be easily 
diagnosed in the field and the module can be swapped out with a spare and repaired at the factory, 
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Hours: M-F  9-7 Pacific Time
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Site Preparation Guidelines for CASSINI 16 and SPYDER
Revised: 03/08/2007 - 06/12/2017 Topic(s): Admin; Specs Doc ID:RBEH-6Z5482  (2 pages)

The CASSINI (or RI7100C) ATE systems can operate in a wide range of environmental conditions.  
Depending on the system configuration, some specifications may not apply or have individual requirements.  
No special plumbing or ventilation is required.  Customer must provide items designated with "NOT 
PROVIDED" label. All values are subject to change without notice.

Size of RI8591A "Cassini SPYDER" Infrastructure: (preliminary - subject to change )

Height Min/Max:  741.9/1097.3 mm (29.2/43.2 in.)

Depth:  576.3 mm (22.7 in.)

Width:  772.7 mm (30.4 in.) Includes TIMs

System Weight: 79 Kg ( 174 lbs.) (8 TIMs)

Typical/MAX Shipping Weight:  32/45 Kg (70/100 lbs.)

Size of RI8568B "Cassini 16" Infrastructure:

Height:  1,745 mm (68.7 in.)

Depth:  1,151 mm (45.3 in.)

Width:  843 mm (33.2 in.)

Max Shipping Weight:  250 Kg (550 lbs.)

Fixture: (for docking with a Handler or Prober)

Always consider the Fixture height when determining minimum clearance of the Test Head.

Height: 195.6 mm (7.7 in.)  - includes clearance for alignment pins

Depth: 266.7 mm (10.5 in.)

Width - 8 slot test head:  266.7 mm (10.5 in.)

Width - 16 slot test head:  558.8 mm (22 in.)

Handler/Prober:

Docking options based on Handler/Prober Type:  Hard dock (RIK0070A, HNDPLATE), Soft dock

(Cables)
Handler "Pod" per handler/prober per system: GPIB (RIK0263A), Serial (RIK0266A), Parallel (

RIK0267A)
Requires factory RI configuration and programming, send detailed handler control logic to
"support@roos.com" prior to ship date.
Handler Pod Interface Cable: Parallel 25 Pin Female D-Sub, Serial Female RS232, or GBIP

cable. NOT PROVIDED

Workstation:

Surface not needed for Small Cassini (...56) or Cassini 16 (...68) with Aux Rack, Touch UI (

RI8583A) or Arm UI (RI8599A)
System Controller requires standard CAT-5 RJ45 ethernet network cable to integrate with

network and access Guru Server.
Monitor requires power plug (varies based on monitor C13 or C7).  If available, can be supplied

by AUX rack.
Workspace must be located within network cable reach of the System Controller (adjacent to

system)
Workspace (cart) is needed to hold monitor, keyboard and mouse. NOT PROVIDED

Compressed Air:  ONLY Cassini 16 (RI8568B)

Input Pressure 65-120 PSI (regulated to 90 psi)
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System Connector Type:  Quick Disconnect US Industrial/Milton MIL-C-4109 Male (preferred)

           4109 Male @ Facility Cassini System
Adapters included with system: (MPSNYT5A)

THREAD NPT 1/4" Female @ Facility to Quick Disconnect on tester (option #1)

    Facility 1/4" NPT thread System Connector
HOSE 8mm or 5/16 in.:  Barbed hose adapter and clamp with 1/4" NPT male thread  (option 

#2)

   Hose @ Facility Adapter to THREAD (supplied adapter)

Environment:

Operating Air Temperature: 10° to 35°C (50° to 95°F)

For best calibration performance, a consistent ambient room temperature of ± 5°C is 
recommended.
Humidity: 8% to 80%

General Electrical Input:

Input voltage and frequency ranges automatically.

220 V or 110 V

50 Hz or 60 Hz AC, Single Phase Sine-wave input.

20 AMP Service

NEMA 5-20P Plug Provided (Cassini side is C19)

Other Plug Types: Cut off NEMA provided plug and use pig-tail plug adapter. NOT PROVIDED

Function Label Color, IEC
Protective Earth, Ground PE green-yellow
Neutral N blue
Line, single phase, Hot L brown or black

Cassini 16 (RI8568B) Input kilovolt-amperes (kVA) approximately

Minimum: 0.15 kVA

Maximum: 0.75 kVA

Aux Rack Maximum: 1.2 kVA  (300 VA per Source)

The System Controller and Touch UI (RI8583A) option uses the power supply from the tester.   

Depending on the monitor type, it may use the AUX rack power supply (if available) or need an 
additional outlet.

IMPORTANT Electrical Ground:

It is essential to maintain solid ground between the handler and the Roos system rack. This helps to 
prevent Device Under Test (DUT) damage and damage to the Roos handler interface.

The green ground wire in the back of the Roos rack should be connected directly to the handler 

ground.  This should be inspected each time a handler is connected to the test system by the 
operator.

The ground should be checked each time a handler is connected.  Measure both AC voltage 

(must be less than 50 millivolts) and ground resistance (which should be less than 5 ohms) 
between the tester ground and the handler ground.  
Note: Measuring negative resistance is a sign that DC or AC voltage is present. Any of these 
conditions would indicate failure to ground and should be corrected prior to testing parts.
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Additional information:
Cassini Footprint - Cassini 16 Infrastructure
Cassini Footprint - Cassini SPYDER 8 Infrastructure

 Legacy platform (RI7100A, RI7100C, Cassini Small, Cassini Large) Site-Preparation Guidelines.
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Site Preparation Guidelines for CASSINI and RI7100A&C (Limited 
Availability Infrastructures)

Revised: 07/09/2013 - 07/28/2017 Topic(s): Admin; Specs Doc ID:RBEH-99FTGZ  (2 pages)

The  RI7100A, RI7100C, and all "CASSINI" ATE systems can operate in a wide range of environmental 
conditions.  Depending on the system configuration, some specifications may not apply or have individual 
requirements.  No special plumbing or ventilation is required.  Customer must provide items designated 
with "NOT PROVIDED" label. All values are subject to change without notice.

Size of RI7100A, RI7100C and RI8557A "Large" Cassini Infrastructure:

Height: 1,700 mm (66.9 in.)

Depth: 900 mm (35.4 in.)

Width: 600 mm (23.6 in.)

Maximum Shipping Weight:  300 Kg (660 lbs.)

Size of RI8556A "Small" Cassini Infrastructure:

Height:  1,590 mm (62.6 in.)

Depth:  733 mm (28.9 in.)

Width:  853 mm (33.6 in.)

Maximum Shipping Weight:  250 Kg (550 lbs.)

Fixture: (for docking with a Handler or Prober)

Always consider the Fixture height when determining minimum clearance of the Test Head.

Height: 195.6 mm (7.7 in.)  - includes clearance for alignment pins

Depth: 266.7 mm (10.5 in.)

Width - 8 slot test head:  266.7 mm (10.5 in.)

Width - 16 slot test head:  558.8 mm (22 in.)

Handler/Prober:

Docking options based on Handler/Prober Type.

1 "Handler Pod" per handler/prober per system.  Requires factory RI configuration and 

programming.
Provide detailed handler control logic documentation to "support@roos.com" prior to ship date.
Handler Pod Interface: Parallel "25 Pin Female D-Sub", Serial "Femal RS232", or GBIP cable. 

NOT PROVIDED

Workstation:

Not needed for Small Cassini (...56)

Workspace (cart) is needed to hold monitor, keyboard and mouse. NOT PROVIDED

Workspace must be located within network cable reach of the System Controller (adjacent to 

system)
System Controller requires standard CAT-5 RJ45 ethernet network cable to integrate with 

network and access Guru Server.

Environment:

Operating Air Temperature: 10° to 35°C (50° to 95°F)

For best calibration performance, a consistent ambient room temperature of ± 5°C is 
recommended.
Humidity: 8% to 80%

General Electrical Input:

Sine-wave input (50 or 60 Hz) required - AC, Single Phase

Plug type varies depending on country standards.  (example: NEMA 20 in the US)
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RI7100A Electrical Input:

Input voltage and frequency ranges built for 115V ±10% (or 230V ±10% with option 30A)

System controller and monitor each require a separate 120V power supply outlets.

RI7100A Input kilovolt-amperes (kVA) approximately

Minimum: 0.15 kVA

Maximum: 1.5 kVA

Cassini Electrical Input:

Input voltage and frequency ranges automatically selected (220 V or 110 V)

Cassini & RI7100C Input voltage range:

Minimum: 90 V AC

Maximum: 250 V AC

The System Controller uses the power supply from the tester.   If required, the LCD Display may 

need an additional outlet.

IMPORTANT Electrical Ground:

It is essential to maintain solid ground between the handler and the Roos system rack. This helps to 
prevent Device Under Test (DUT) damage and damage to the Roos handler interface.

The green ground wire in the back of the Roos rack should be connected directly to the handler 

ground.  This should be inspected each time a handler is connected to the test system by the 
operator.

The ground should be checked each time a handler is connected.  Measure both AC voltage 

(must be less than 50 millivolts) and ground resistance (which should be less than 5 ohms) 
between the tester ground and the handler ground.  
Note: Measuring negative resistance is a sign that DC or AC voltage is present. Any of these 
conditions would indicate failure to ground and should be corrected prior to testing parts.

Legacy Infrastructures:
Cassini Footprint - 56 Small Infrastructure
Cassini Footprint - 57 Large Infrastructure & RI7100C 
RI7100A Footprint
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Cassini Test Floor Integration Checklist
Revised: 04/07/2012 - 07/28/2017 Topic(s): Admin; Specs Doc ID:RBEH-8T5SLV (1 Page)

Cassini is designed for modern test floors with minimal requirements.  This high level 
checklist is useful for preparing for new Cassini installations.

Physical Location, Site Preparations
Plug Type, 220V+
Pressurized Air
HVAC (none)

Handler, Prober
Test Head Orientation
Handler/Prober POD programming (Specify MFG or provide manual)

Cable NOT provided.  (custom Serial or Parallel cable created onsite, or 4 
meter MAX GPIB)

Docking Solutions
ROOS Adapter Plate
3rd Party
In House Custom
Soft-dock

DUT Interface
Fixture Planning (Custom Testhead)
DUT Interface Board Design (Site locations, Handler Pitch)

Software/System Controller
Network Integration (TCP/IP)
Data Storage & Transfer

Guru Server
Backup and Disaster Recovery

Users & Permissions
Care and Maintenance

System
Fixture
DIB
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Cassini 16 Infrastructure Footprint
Revised: 10/26/2006 - 07/28/2017 Topic(s): Admin; Manufacturing; Specs Doc ID:RBEH-7VA5TL  (4 pages)

Values are subject to change without notice.  Additional environmental information is available in the 
RI Site Preparation Guidelines document. Cassini 16 requires compressed air (used when docking 
Fixture). Not Shown:  Monitor, Keyboard, Mouse (workspace must be provided, Aux rack is suitable)

Size of RI8568B Cassini 16 Infrastructure:

Height:  1,745 mm (68.7 in.)

Depth:  1,151 mm (45.3 in.)

Width:  843 mm (33.2 in.)

System Weight: 105 Kg ( 230 lbs.) 

Typical/MAX Shipping Weight:  250 Kg (550 lbs.)/ 385 Kg (850 lbs.)
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Docking Limits
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Rev1
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With Auxiliary Rack (Optional) attached on the Right:

With Auxiliary Rack (Optional) attached on the Left:
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Cassini SPYDER Infrastructure Footprint
Revised: 07/09/2013 - 07/28/2017 Topic(s): Admin; Manufacturing; Specs Doc ID:RBEH-99FTBY (1 Page)

Values are subject to change without notice.  Additional environmental information is available in the 
RI Site Preparation Guidelines document. 

Size of RI85XXB Cassini SPYDER Infrastructure:

Height Min/Max:  741.9/1097.3 mm (29.2/43.2 in.)

Depth:  576.3 mm (22.7 in.)

Width:  772.7 mm (30.4 in.) Includes TIMs

System Weight: 79 Kg ( 174 lbs.) (8 TIMs)

Typical/MAX Shipping Weight:  32/45 Kg (70/100 lbs.)

Docking Limits
Note: A Fixture adds 195.6 mm (7.7 in.) in height, including clearance for docking.
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Cassini Short 8 Infrastructure Footprint (Ri8556A)
Revised: 08/25/2009 - 07/28/2017 Topic(s): Admin; Manufacturing; Specs Doc ID:CRRS-6UXVG4 (1 Page)

Note: This model is "limited supply".  Use Cassini SPYDER instead.

Values are subject to change without notice.  Additional environmental information is available in the 
RI Site Preparation Guidelines document.

Size of RI8556A Small Infrastructure:
Height:  1590 mm (62.6 in.)

Table Surface Height: 925 mm (36.4 in.)

Depth:  733 mm (28.9 in.)

Width:  853 mm (33.6 in.)

Max Shipping Weight:  250 Kg (550 pounds)
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Cassini Tall 8 Infrastructure Footprint (Ri8557A)
Revised: 03/09/2007 - 07/28/2017 Topic(s): Admin; Manufacturing; Specs Doc ID:RBEH-6Z62AZ  (2 pages)

Note: This model is "limited supply".  Use Cassini SPYDER instead.

Values are subject to change without notice.  Additional environmental information is available in the 
RI Operating Environment Guidelines document.

Size of RI8557A Large Infrastructure:
Height:  1698 mm (66.9 in.)

Depth:  900 mm (35.4 in.)

Width:  838 mm (33.0 in.)

Max Shipping Weight:  300 Kg (660 pounds)
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Optional Cart must be adjacent to system rack  (limited by length of RIFL cable)
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RI Safety Guidelines for Hazards - Cassini
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin; Manufacturing Doc ID:RBEH-8F8U8A  (2 pages)

General Safety

RI systems are designed with an emphasis on safety and introduce no hazards that should be 
considered in an OSHA

1

 compliant safety program. The topics below review specific issues, but 
each section discusses how hazards are not exposed in the normal operation of a RI Test System.   
If the system is used in a manner not specified in the instructions, the protection provided by the 
equipment may be impaired.  The warnings below are based on a standard operating air 
temperature is from 10° to 35°C (50° to 95°F) and humidity from 8% to 80%.

Conforms with the essential requirements of the EMC Directive 2004/108/EC and LVD 
Directive 2006/95/EC, based on the following specifications applied:
EU Harmonized Standards:EN 61326-1:2006, EN 61000-3-2:2006+A1:2009+A2:2009, EN 
61000-3-3:2008, EN 61010-1:2001CE 
Certificate available upon request.

2

Pinch Point Hazards

Always use caution when docking the Handler or Prober to the Fixture and Fixture to the Test 
Head.  For some models, a pinch hazard only occurs when the test manipulator arm is moved to a 
maximum (up) or minimum (down) position.  Do NOT insert fingers into the protected manipulator 
arm path at any time.

Electrical Shock Hazards

There are NO electrical shock hazards from any of the exposed electrical connections on the test  
head or on any surface of the system.  The system uses 48 volts or less and shock hazards are 
typically designated as to 50 volts or higher 

3

.  No high-voltage cables or connections are exposed 
at any time during operations or when moving the system.  Fixtures and Tester Instrument Modules 
(TIMs) can be safely removed "hot" without disconnecting power without damaging the equipment 
or exposing live connections to the operator.  The system is equipped with an Emergency Off 
(EMO) button that instantly disables all 48 volt connections.  The "Main Breaker" is used to 
disconnect all electrical connections and should be switched "Off" before performing any 
infrastructure maintenance that requires tools to remove protective metal covers.

IMPORTANT EXCEPTION: RI8589 Pulser can pulse up to 220V for a short time, exposing a burn 
risk to fingers if they touch the active terminal while Diagnostic or Calibration testplans are run.
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Ergonomic Hazards

Repetitive stress injuries created by ergonomic workstation hazards are not of concern with normal  
system operations.  Operators are NOT expected to use the touch screen or mouse and keyboard 
for an extended period of time (more than an hour).  Most operators only use the system for 
minutes at a time, below industry guidelines for workstation safety

4

.  If the system is primarily used 
for test plan development, however, extended periods of work may occur.  A chair or stool with 
proper height adjustment and back support or a padded mat for standing support is suggested if  
the person remains in position for more than 60 minutes with 5 to 10-minute breaks.

Fire and Chemical Safety Hazards

There are NO explosive or combustible materials in the system.  No chemical safety guidelines are 
required because no hazardous chemicals are used in the operation of the system.  Exposure to 
hazardous amounts of lead is not possible due to the lack of direct contact to components that may 
have been soldered with lead.  As a precaution, DO NOT EAT, DRINK, OR SMOKE after handling 
damaged internal electronic components until you have washed your hands.

RoHS Exemption

RI is exempt from RoHS standards for lead free components due to the performance 
characteristics of lead free components and the class of hardware

5

 (EEE Cat. 6: Large-scale 
stationary industrial tools).

Footnotes:

1 - Occupational Safety & Health Administration, http://www.osha.gov/
2 - CE Declaration of Conformity for Cassini 16 attained June, 16 2011.
3 - Encyclopaedia of occupational health, Jeanne Mager Stellman, pg. 52-5
4 - Handbook of OSHA constructions safety and health, Charles D. Reese, pg 218
5 - ROHS Directive, UK Government, http://www.rohs.gov.uk/DecisionTree.aspx?id=21, 
http://www.rohs.gov.uk/Docs/All%20Current%20Exemptions%202011.pdf
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Adding another Test Instrument Module (TIM) into a Cassini tester
Revised: 08/30/2007 - 09/15/2014 Topic(s): Admin; Diagnostics; Manufacturing Doc ID:RBES-76KTXH 

This document describes how to add a new Test Instrument Module (TIM) into a Cassini Test Head. This 
document applies to any new TIM or reconfigured TIM, even if is the same model number as a previously 
installed TIM. Note that a TIM is any hardware with a unique RIFL node, including testhead TIMs as well as 
rack instruments.

The TIM will be supplied with a Guru zip file (gzp) containing instrument and cal definitions. Import 

these definitions as follows:

Copy the files onto a temporary directory on the computer's hard drive. 1.
Open the Guru browser.2.
Import the definitions into Guru per the Browsing, Importing and Exporting Guru Objects 3.
document.
(Paraphrase: Use Guru Browser from any system to load .gzp into Guru)

Plug the TIM into the testhead.

Perform a 'System' 'Check.'

Note that the TIM calibration information is added when the TIM's guru objects were loaded, so the TIM 
should already be calibrated.

Confirm that the TIM has been added and that the calibration data is valid.

After installing the TIM, if the installation is intended to be permanent, the tester definition should be saved 
as follows:

Open the configuration window (big 'System' button, 'Tester')

In the menu, select 'Tester' 'Save'.

Note that the saved tester definition controls two main functions:
1) When multiple copies of the same instrument exist, the definition differentiates them, naming which is 
instrument1 and which is instrument2, etc.
2) The definition enables simulated testers to know the tester's precise configuration.

Also note that, if the installation is intended to be permanent, the tester's calibration list may have to be 
modified to include service plans for the new TIM for future Calibrations.

If a TIM with the same model number is being added (for example, a second RFSource), a couple of special 
aspects must be considered:

The tester will automatically assign the next number to the instruments in the TIM. For example, if a 

second RI8546C is added, containing the DutControl, PowerVI, and StaticDigital instruments, the 
new instruments will be assigned as DutControl2, PowerVI2, and StaticDigital2.

It's particularly important that the tester be saved after this type of installation. If the image is closed 

and re-started, the tester will need the tester definition to know which of the duplicate TIMs is the first 
and which is the second.

If the above procedures are followed, installing a new TIM is straightforward and easy.
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Cassini 16 Diagram (Location and Descriptions)
Revised: 04/01/2011 - 

07/28/2017
Topic(s): Admin; Guru Help; Manufacturing; R&D; 

Specs
Doc 
ID:

RBEH-8FHTV5  (3 
pages)

The following diagrams show the location of Cassini 16 features.

Cassini 16 Front

Fixture (16-slot)  (Compatible with 8-slot Fixtures)1.
Test Head2.
Fixture Alignment Holes3.
Test Instruments Module (TIM) Slots  (qty 16)4.
Counterweight (Adjustable)5.
Test Head Alignment Lock and Indicator6.
Tower (Holds Manipulator Arm & Test Head)7.
Fixture Latch/Unlatch Switch8.

9.  Test Head Height Up/Down Buttons
10. Cassini System Movement Handles
11. Emergency Off (EMO) for 48V
12. DC Power Supply Service Access Panel
13. Handler Grounding Wire (Alligator Clip)
14. Air Supply (Pressurized) Connection
15. DC Power 48V Distribution Switches
16. System Monitor/Keyboard/Touch Pad
     (Touch screen attached to tower- Optional)
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Cassini 16 Back

Emergency Off (EMO)1.
Air Supply (Pressurized) Connection2.
Main Breaker (20 Amp)3.
AC Power Cord Connection (220-230V @ 50 Hz)4.
Feet for Locking Movement & Stability (qty 2)5.
System Monitor/Keyboard/Touch Pad6.
(Touch screen attached to tower- Optional)
Test Head Arm Height (Up/Down)7.
Fixture Latch/Unlatch8.

9.   System Serial Number
10. System Off/On/Start Switch
11. System Power "ON" Light (blue)
12. Monitor/Keyboard/Mouse/USB/Network
13. System Controller TIM



Cassini 16 Diagram (Location and Descriptions)(Cassini Maintenance Manual - )

Page 22

Back of Test Head 

Fixture1.
Test Head2.
Fixture Align & Lock Lights (Red = Bad or Green = Good)3.
Test Head Rotation Lock (0,90,180), ok leave unlocked when docking at any other angle.4.
Test Head Arm5.
RIFL Hub (Qty 4 round "RIFL 3" ports)6.
(Not Pictured) Test Head Weights (for Fixtures exceeding 20 lbs.)7.
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Unpacking a Cassini 16 from Shipping Crate
Revised: 02/17/2011 - 07/28/2017 Topic(s): Admin; Manufacturing Doc ID:RBEH-8E6PZV  (5 pages)

Instructions from the Cassini Reference Guide.

Previous instructions
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Setting Up the Cassini 16 Test System for the First Time
Revised: 02/14/2011 - 07/28/2017 Topic(s): Admin; Manufacturing Doc ID:JWAD-8E3P5G  (4 pages)

This document provides you with a step by step process for getting your new Cassini16 up and running.

At this point, the system and TIMs have been uncrated and moved into position. Take a few minutes and go 
through the following steps:

1. Check all switches and circuit breakers. Make sure all are in the "Off" position. Also, check the Fixture 
Latching Switch. It should be in the "Unlatched" position.

  

 

2. Check the system and all connectors for any signs damage. Look closely at pins and pin housings. Pins 
can sometimes get pushed down to far into the connector. Look for cleanliness and security of the system 
and all switches & connectors. When cleaning the connectors, use compressed air to clean the connectors 
on the testhead. Use an all purpose cleaner to clean the system. Its best to spray the cleaner directly onto a 
cloth to wipe down the system vs. spraying the cleaner on the system.

  

3. Make sure the Docking Control Knob is in the 'Maint Lock' position. This is to prevent the testhead from 
moving around during set up. Its use is to allow both 'backward & forward' and 'side to side' movement of the 
tester when preparing to dock to a handler or prober. (NOTE: this knob should be in the Maint Lock position 
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prior to shipping). It should also be in this position when not attached to a handler/prober and maintenance of 
the system. Also note that, while in the 'Maint Lock' position, the testhead is still allowed some movement. 
This is normal. 

4. Install the TIM's into their assigned locations. Remember to check the connectors for any signs of damage 
to the pins or pin housings. Also check for cleanliness and security of the connectors.

 

5. Plug in the main AC line cord.
 
6. Install the compressed air hose to the fitting on the side of the system. This is used for the latching & 
unlatching of the fixture.

7. Check the systems Emergency Off Switch (EMO). Make sure it is NOT engaged. Pulling 'up' on' the switch 
will disengage it. 
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(Note) If your system comes with a desktop monitor & keyboard. Install it now. If it comes with the monitor 
and keyboard attached to the manipulator column, proceed to the next step.
The connectors for the monitor & keyboard are attached at systems computer. You will have to make the 
connections at the monitor & keyboard.

8.  Switch the "Main" breaker to "On". Then switch the "DC" breakers to "On". Then, turn the Systems Start 
Switch to "Start", then release the switch. It will default back to the "On' position. Turn on the monitor for the 
PC.
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WARNING!  Fixture should NOT be attached to the Test Head while powering 
on the system.

The Test Fixture should not be connected when turning the system on.  It could be 
possible to damage the Fixture or device because the System Controller has not yet 
reset the states of the Test Head.  The fixture can be freely swapped while the system 
is idle or off, but a fixture should not be connected during start-up.
NOTE: The Diagnostic/Calibration Fixture especially should NOT be connected, it will 
damage the DevicePower TIM (RI8546A,B,C) as the system starts-up.

You are now ready to login and start using the system. Contact your System/Network Administrator to get 
the tester 'network settings' configured if required.

Maintenance: Setup System Networking (TCP/IP) - http://roos.com/docs/RBEH-7KSSWS?Open 
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Setup System Networking (TCP/IP and FTP)
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8FWPEW  (4 pages)

Networking: TCP/IP

TCP/IP Settings Notebook

IP address, netmask

Default Route

Servers

FTP server setup

The network settings are handled by the embedded operating system (eCS), System 
Settings application.  The system controller is pre-configured to use DHCP to 
automatically assign appropriate network settings.  However, if the system controller 
needs to use a static IP address, the following instructions will be helpful.  The network 
must be properly configured for Guru to operate.  If your network has a dedicated Guru 
Server, you can use the Guru Address Book to configure the connection to that server.  
If not, you can access the RI's main Guru Server via the internet to simplify software 
updates and support requests.  The network administrator should review the Guru 
Network Preparation Guidelines - connecting to guru.roos.com document.

NOTE : Please contact RI Support for assistant with setting up the TCP/IP networking.  
First make sure you have access to the following information for your network 
environment; IP address, TCP/IP Netmask, Default Route, and DNS Server or static 
host names.
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TCP/IP: IP Address, Netmask

Typical TCP/IP: IP Address, Netmask setup screen.

To see the current IP address, use command "ifconfig lan0"
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Enable FTP Server with TCP/IP: Services

Typical TCP/IP: Servers setup screen enabling the FTP Daemon to run in the 
background and handle FTP requests.
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FTP Capability

Use the FTP applications provided by eCS (GUI or CLI) to FTP out 
from the system
FTP Daemon must be set to Autostart to accept FTP connections
TCP/IP Security must be set for at least 1 user
User must have a Password (min 5 characters)
Available drives or files for FTP need to be set
(use Negative logic to share all files and drives)
Must set FTP enabled

BINARY - Always transfer files in binary mode.  ASCII mode will corrupt 
.zip files because of the line feed conversion (ln -> ln+rf).  To put the 
standard FTP client into binary mode enter the command "binary" 
before starting the file transfer.

This FTP capability is primarily for administrative activities.  The preferred 
way to transfer test data is with the Guru Agent that is explained in a later 
lesson.
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Standard Service Procedure for RI Service
Revised: 03/29/2007 - 07/28/2017 Topic(s): Admin; Diagnostics; Fixture Doc ID:CRRS-6ZS5K4 (1 Page)

There are 4 major components that enable production test to be successful: parts, 
socket, fixture, system.  If anyone of these components fails, production test will be 
interrupted.  This list includes the procedures recommended by RI to determine which 
part of the test process is failing.  Send all support requests to RI at support@roos.com.

1) Parts:
Run the silver parts that were used for correlation. If the silver parts pass, the 
problem is likely a part failure.  If known good parts still fail, save the detailed test 
data and send this data to Support at RI.

2) Socket:
Inspect the socket and clean the DUT Board surface under the socket and the back 
of the DUT board.  Run some silver parts using a manual actuator.  If the parts pass, 
the problem is likely the connection to the Handler.  If the parts still fail, save the 
detailed test data and send to RI Support.

3) Fixture:
Use extra (spare) fixture on the tester where the problem is suspected.  Run the test 
plan and determine if test issues are cleared or if they remain.  If test issues are 
cleared by using the spare fixture, the problem is with the fixture, the DUT board or 
the socket.  The fixture and the docking interface will need to be inspected to 
determine the cause of failure. The fixture is not covered by a service contract.  
Repairs for parts and repair labor will be charged separately. 

4) Tester:
If the spare fixture shows the same problem as the original fixture, then there is a 
reason to inspect the tester.  Run the diagnostics on the tester and send the results 
to RI Support.  If a system failure is suspected, notify RI Support to request a new 
service report to document the suspected problem.   Send the Fixture definition, bad 
data and the good data results on the parts to RI Support.  Support is available 
continuously and will be reviewed and replied to quickly. 

Only spare Test Instrument Modules (TIMs) should be used for swapping into the 
tester with suspected problem.  Do not swap TIMs from a tester with suspected 
problem into a tester that is operating correctly.  If no spare module is available, a 
complete review of diagnostics is required prior to any internal inspection of 
modules.

A spare module should be loaded into the tester and the defective module should be 
shipped to RI Santa Clara for repair. RI will issue an RMA for this return shipment. 
Please list the RMA on the return shipping paperwork.  If a spare module is not 
available, the defective module needs to be returned to RI Santa Clara for repair.  RI 
Santa Clara will ship a spare module as quickly as possible. However, this will take 
longer due to the time required to ship the module. 
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Cassini Maintenance Schedule Guidelines
Revised: 03/22/2012 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8SMRN9  (2 pages)

Cassini is designed for constant (100% 24x7x364) use in a production environment and 
requires only a minimum amount of scheduled downtime to maintain performance.  These 
guidelines can be adjusted based on your risk threshold and operating environment, 
extending the time between planned processes (activities below) when used in a lab 
setting, very low volume production, or a thermally stable (+- 5° C) and "class 3+ 
cleanroom" test floor.  The frequency and details of the procedures listed in the Preventive 
Maintenance Schedule can be adapted to your needs. For example, if you are changing 
Fixtures daily, you may want to inspect the connectors between the Fixture and Handler 
more frequently.  Calibrations can be safely postponed if the system is in a thermally 
stable environment where the ambient temperature does not vary by more than 5° C.

RI Recommended Preventive Maintenance Schedule Summary

Process
1

Daily Monthly Quarterly Yearly As Needed
2

Socket Socket MFG Suggested
DUT Interface Board (DIB) >10% Yield Changes

Test Head TIM Ports 1k Fixture Docks
Fixture Inserts @ DIB 1k DIB Installs

Docking Hardware 1K Docks+
Handler POD to Test Head RIFL Cable 

(damage)
If Frequent Handler 

Changes

Diagnose/Verify
Yield Drops,

Debug
TIM/System Calibrations TIM Swap

AUX Rack only: RF Cables TIM Swap

Fixture Calibrations
Modification
or Damage

1 
 Process: Inspect for damage or wear, Clean or Replace as needed.

2
 As Needed: The procedure should completed either by the time period or approximately by the frequency of 
events listed in this column, whichever occurs first.
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RI Recommended Preventive Maintenance Schedule Details

Process
1
 (same as above)

Est. Time To 
Complete Role/Login Tools Needed

3
Contact RI Support

Socket 1-2 minutes Operator Standard Tools 

DUT Interface Board (DIB) 10 min Maintenance
Standard Tools, 

Volt Meter, 
Magnifier

Test Head TIM Ports 2 min Operator Standard Tools 
Fixture Inserts @ DIB 1 min Operator Standard Tools 

Docking Hardware 30 sec. Operator If wear found
Handler POD to Test Head RIFL Cable 1 min Operator

Diagnose/Verify

1-5 min 
(Selective)

1 hour 
(Complete)

Maintenance
Diag/Cal Plate, 
Power Meter

TIM/System Calibrations

10 mins-2 hrs 
(Selective)

4-6 hrs 
(Complete)

Maintenance
Diag/Cal Plate, 

Full Cal. Kit

AUX Rack only: RF Cables 2 min Maintenance AUX Rack

Fixture Calibrations
Varies (Minutes 

to 1-2 Hrs)
Designer OSL Cal DIBs

1 
 Process: Inspect for damage or wear, Clean or Replace as needed.  Diagnose/Verify and Calibrations are 

"Run".
3
 Tools Needed:

Standard Tools = Pressurized Air, Cotton Swabs, Tweezers, Alcohol
Diag/Cal Plate = Provided with System (can be shared with systems with identical TIM configurations)
Full Calibration Kit = Onsite or RI Provided (during PMC visit)
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Cassini Regular (Daily) Maintenance
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8FWRGU  (3 pages)

Roos Instruments recommends that the following Preventive Maintenance Procedure be 
carried out any time the tester is docked or undocked to keep the Cassini ATE System 
at its peak performance.

Daily maintenance may require cleaning and or repairing of sensitive electronic 
connections.  Use isopropyl alcohol (at least 90%) to clean connectors, use dry 
compressed air to remove debris.  If the contamination is not removed, you should stop 
all operations, shut-down the component and remove it for maintenance.  The 
components can be replaced on-site or repaired at RI depending on the severity of the 
contamination or damage.

Visually inspect the following items, clean and make any repairs as necessary:

1) Carefully inspect the Socket and Load Board connections.  Look for any physical 
damage, bent pins or fingers, and contamination such as dirt, dust, or metal flakes. 
Particularly, look for small pieces of conductive debris that would prevent a good 
connection between the DUT and socket.

2) Check all of the Microwave and DC connectors between the Fixture and Test Head, 
located on the bottom of the Fixture. 
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3) Inspect the Docking Hardware for mechanical wear.  Improper alignment can cause 
intermittent measurements.
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4) Finally, check the RIFL cable and attached to the Handler Pod and inspect for any 
damage or loose connections.  Also verify that the handler grounding wire alligator 
clip is properly attached to an exposed piece of metal on the handler.

If everything looks normal, then run some know devices through normal tests to check 
for basic correlation.  If there is physical damage to the cables or Handler Pod, the 
system should be brought down for maintenance and a service call requested.  It will be 
necessary to replace the failing connector/cable assembly.
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Cassini Periodic Maintenance (Verify TIMs)
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin; Diagnostics Doc ID:RBEH-8FWRHB  (2 pages)

Roos Instruments recommends that the following Preventive Maintenance Procedure be 
carried out regularly to keep the Cassini System operating at peak performance. 

1) Perform the regular (daily) Maintenance: Visually inspect all of the Microwave 
connectors between the Test Head and Fixture. Look for any physical damage, bent 
pins or fingers, and contamination such as dirt, metal flakes, etc.  Also check the 
physical interface between the Fixture and Handler for signs of wear.

2) Connect the Calibration/Diagnostic Fixture to the RI 

Head Rotation Lock

Test Head using the guide pins in the RI Test Fixture to 
align the Calibration/Diagnostic Test Fixture with the RI 
Test Head. (Note: The "RI Logo Arrow" should point 
towards the RI manipulator tower.) Four alignment pins 
protruding from the Test Fixture guide the assembly 
together, changing the Fixture Align light to green.  
Move the Fixture switch to "Latch" to lock the Fixture to 
the RI Test Head, guaranteeing  the correct RI mating 
pressure between the Fixture and the Test Head.  

Test Head vertical Alignment (UP/DOWN) and Latch

3) Perform the "System Verify Procedure" for each TIM, listed by Model number.   
From the Cassini window, press "System" button, then "Tester" to open the 
configuration window and select "Diagnose" from the "Tester" menu.  Choose the 
appropriate configuration from the list that matches the current arrangement of TIMs 
and press "Select".   Now select the verification Test Plans and choose "Run", 
"Selected".   Follow any on-screen instructions, making sure the connectors are 
properly seated in the diagnostic fixture.  This will verify that the system is meeting 
it's calibrated performance specifications.  If there are any failures, rerun that specific 
Diagnose, document the failure, and request service.
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Diagnose and Verify Cassini TIMs
Revised: 10/30/2008 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-7KWVVU  (2 pages)

Diagnose/Verify Cassini Test Instrument Modules (TIMs)

Diagnose/Verify Testplans are run to confirm that the instruments are operating and 
calibrated properly.  If a Diagnose test fails, all of the testplans in the "Diagnose" 
window should be run to help identify the issue.

Note: The Diagnose list can contain both diagnose and verify Testplans.  When running 
procedures from a diagnose list, run all of the testplans, including ones named "Verify."

RI uses "return to factory" to repair modules.  Contact support@roos.com for a RMA 
and help diagnosing any problems encountered.

Install the "Diag. Fixture" that is used to route signals and directly access TIM ports 
BEFORE running the Diagnose plans.  Use the "System - Check" button after adding 
the fixture make sure it is identified by the system.

From the Cassini application, select System button, then Tester.  



Diagnose and Verify Cassini TIMs(Cassini Maintenance Manual - )

Page 41

From the Tester Configuration window, select Diagnose from the Tester menu.

Select a few tests for the instruments that are suspected to be invalid, and choose Run 
| Selected from the Verification window.  Monitor the results for Pass and Fail.  

If a "FAIL" result is encountered, run all the  Diagnostics and send the results to 
support@roos.com.

To send results from the Diag list, select 'Results' 'Save to Guru'. The test data is saved 
as an 'RiEquipDiagLog' object class, with the tester's name as the title, and the current 
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date/time. Use the Guru Browser or Guru Exporter to export a ".gzp" file with the test 
data and then send it to Roos.
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Checking Wear Levels of RF Relays and Attenuators
Revised: 02/26/2011 - 07/28/2017 Topic(s): Admin; Manufacturing Doc ID:RBEH-8EG56J (1 Page)

Some instruments in Cassini TIMs have mechanical RF relays and step attenuators that wear out after being 
switched millions of times. The available life left is based on the specified lifetime for each component, 
usually 10 million switches. Each component has it's own life expectancy built into the system.

The wear levels are displayed when the tester is started.

When the wear level reaches 70% of the available life, a full Preventative Maintenance and Calibration 
procedure should be scheduled. When the wear level reaches 95% of the available life, or if the performance 
degrades, the TIM containing the Relay or Step Attenuator should be serviced.
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Cassini Fixture Care and Maintenance
Revised: 03/28/2011 - 07/28/2017 Topic(s): Fixture; Guru Help; R&D Doc ID:RBEH-8FE538  (6 pages)

RI Fixtures use robust mechanical and electrical connections to survive the rigors of high volume 
semiconductor production.  Regular repeated use without proper maintenance, however, can reduce the 
functional lifetime of the fixture.

Do's:
Store Fixture in a protected place when not in use such as a metal cabinet or book shelf.

Make sure that the shelf it sits on is clean. The installed standoffs will allow the fixture to sit 

without damage to the connectors.
Check DC and RF connections periodically to ensure good contact and that damage has not 

occurred.

Don'ts:
Store the fixture in such a way as to allow objects to contact the bottom surface. Anti-static 

Styrofoam is OK. Doing otherwise may contribute to pin breakage or RF connector damage. Do 
not store on WIRE shelf racks.

Fixture Cleaning:
The Cassini family of testers use PKZ#12 connectors for the testhead-to-fixture interface. Like all 
connectors, they can become contaminated and need to be cleaned. PKZ#12 connectors are small. 
Standard cleaning methods, such as a cotton swab, are difficult to use on this connector and can damage 
the connector. This document shows how to clean PKZ#12 connectors using spray cleaner and spray 
duster.

This technique works for both the male and female connectors.

To clean the connector, first use a good, static-safe, chemical cleaner, such as TF-Cleaner. If TF-Cleaner 
is not available, use an equivalent cleaner. Alcohol-based cleaners are acceptable, however cleaners 
that contain oils such as tuner cleaner, are not acceptable.
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Using this, or an equivalent cleaner, spray a small amount into the connector. This will flush any debris or 
contaminants out of the connector.

CAUTION! Be sure to use a cleaner that is not harmful to skin. Do not allow the cleaner to get into your 
eyes or other sensitive areas.
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After flushing the connector with cleaner, use a 'duster', such as shown to dry the connector. Clean, dry 
air or stable gas such as CO2 are acceptable. Spray the duster into the connector to thoroughly flush any 
cleaner and dry the connector.

With this process, PKZ#12 connectors can be thoroughly cleaned without harm to the connector.

DIB  Cleaning:
Using Isopropyl alcohol (strength at least 98%) and a clean Q-tip or Kim-wipe, wipe the contact 1.
side of the RF and DC  interfaces carefully (see picture 2). Also wipe the tips of the pogo pins 
themselves.
Repeat step 1 for the contact pads of the socket (see picture 3).2.
Use dry air to blow off any left over fibers left behind by the Q-tip and/or Kim-wipe.3.

Socket Cleaning:
Inspect the socket for any broken or misaligned contacts. 1.
Replace bad contacts using the manufacturers prescribed replacement procedures.2.
Use a mild stream of air and/or a soft artists brush to remove loose debris from the socket when 3.
needed.
Follow the manufacturers prescribed cleaning process for debris that is not easily 4.
removed. 
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Pictures:
Picture #1
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Picture #2

Picture# 3
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RF Connector Care - Handling coax cables
Revised: 07/25/2011 - 07/28/2017 Topic(s): Fixture; Guru Help; R&D Doc ID:RBEH-8K557Z (1 Page)

Many people, even those who have worked with RF, don’t know how to properly connect 
a coax connection.

Always turn the coupling nut, do not spin the center conductor
Do not twist the cable
On AUX rack cables, do not try to put a wrench on the gold trim cap

The key to any connecting any coax connector is to remember that the center conductor 
should not spin. The center conductors usually have a thin gold plate on them. If you 
spin the connector excessively, it can wear off the gold plate, which allows the connector 
to oxidize and causes poor connections.

Note that, on the back of the Roos test systems, we might use right-angle connectors. 
These connectors have a decorative gold cap on them that looks like it can take a 
wrench. IT CAN NOT. It is only glued on, and will come off if you try to use a wrench on 
it.



Cassini System Calibration Procedure(Cassini Maintenance Manual - )

Page 52

Cassini System Calibration Procedure
Revised: 01/10/2007 - 07/28/2017 Topic(s): Admin; Diagnostics Doc ID:RBEH-7K46LQ  (3 pages)

SYSTEM CALIBRATION SETUP PROCEDURE

Use the following procedure to prepare the Cassini Microwave Test System for system 
calibration.  Typical Calibrations take about 4 hours for a 4 port system to complete.  Be 
sure all the equipment used to calibrate the system are calibrated themselves to 
National standards agency (such as NIST in the USA) traceable standards.

If the system is not already running, turn on the system's main power and the 1.
system controller's monitor.  

Select "Logon" from the Guru control bar and log on as a user with admin privileges. 2.
(default admin, password)

The RI System Software (image) is started by selecting the appropriate shortcut 3.
from the 'Shortcut' key on the Guru control bar.

The image will start. It will then find all the hardware (enumerate), identify all the 4.
connections, and set the tester to its idle state. While this is occurring, monitor the RI 
Message Window. If the RI Message Window displays an Error and/or a Warning 
message, please correct the problem before continuing. After the system activity has 
completed, the System Start-up is now complete.

Connect the Power Meter to the RIFL bus thru a GPIB-RIFL translator (pod).  If the 5.
system uses an existing GPIB instrument, do not connect a second GPIB-RIFL pod.  
Instead, chain the Power Meter's GPIB cable to the back of the existing pod.
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ACTIVATING THE CAL INSTRUMENTS

The following instruments must be activated before calibrating:

Calibration Fixture
Calibration Kit
Power Meter

Begin by opening the System Configuration window as follows: Select the big 1.
'System' button. Then select 'Tester' to open the configuration window.

The calibration fixture should activate when connected. Connect the calibration 2.
fixture to the RI test head using the following procedure.

Before connecting the calibration fixture to the test head, visually inspect the a.
fixture and test head connectors so they are straight and all the RF pins are 
good.

Use the four guide pins in the test head to align the calibration test fixture with b.
the test head.

Make sure that all calibration standards are working in good order, look for c.
straight pins and overall cleanliness.

Press the calibration test fixture downward on to the test head.  Pressure should d.
be applied evenly across the top of the calibration test fixture.

Push the test head's fixture release button and slide the fixture locking e.
mechanism to hold the fixture in place.

Perform a system check as follows: Select the big 'System' button. Then select f.
'Check'. After the check is complete, the fixture should now show in the 
configuration panel.

The Calibration Kit contains the coefficients for the open/short/load and noise 3.
standard calibration components. Contact "support@roos.com" for an updated 
calibration kit definition (.gzp) that is imported into guru using the Guru Browser 
application.

Activate the Calibration Kit as follows:

In the Configuration window, select 'Instrument' 'Add cal Kit'.a.

Select the appropriate calibration kit and select OK. Note that, for accurate b.
calibration, the calibration kit definition must match the calibration hardware.

The calibration kit should now be in the Configuration window.c.

To activate the power meter, select 'Instrument' 'Add Power Mtr'. Accept the default 4.
instrument name of 'Pmeter'. Then accept the GPIB address of 13. Note that it is 
Roos' policy to always keep power meters at GPIB address 13. On the power meter, 
the remote light should flash on, then off. The Pmeter instrument should now be in 
the Configuration window.
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PERFORMING THE SYSTEM CALIBRATION PROCEDURE

The RI System Software provides a Calibration Test Executive for calibrating the tester. 
The Calibration Test Executive enables you to run multiple calibration and verification 
test plans. The Calibration Test Executive automatically saves the calibration data, if the 
verification test plan passes. The calibration process takes approximately 4 hours for a 
2 source, 4 port RFIC Test System.

Open the Calibration Test Executive as follows:1.

In the Configuration window, Highlight the 'system' instrument.a.

Select 'Instrument > Calibration > Calibrate'. The system will pop-up a list of b.
calibration executives.

Highlight the appropriate calibration executive and select OK. The Calibration c.
Test Executive should now be open.

Select and run calibration and validate/verify test plans in the order on the test 2.
executive. Note that the tester only saves the Calibration factors after all selected 
plans have been run, so run only a few plans at a time. With this method, if a 
validate/verify fails, then only the cal factors from the selected plans will be lost. 

Run the plans as follows:

Highlight the test plans by clicking on the test plan name to select it.a.

To run the selected tests, select "Run" and "Selected" from the menu bar.b.

Follow the operator prompts provided by the test system while it runs the c.
calibration plan.

Repeat steps a through d until all of the test plans have been performed.  If the d.
validation test plan fails, run the Diagnostic tests for the Instrument that failed.

After all instruments have been calibrated, the System Calibration is considered 3.
complete, you can close the calibration window.

Collect "System Description" to identify every serialized instrument in the system.  4.
(From the Tester panel, select "Tester | Create Config Log...")  Send the Config log 
to RI Support (support@roos.com).

If Roos Instruments performs the calibration, a "Calibration Certificate" that provides 
NIST traceable Model and Serial Numbers and "Calibration Sticker" to be attached to 
the infrastructure will be sent via standard mail in 3-6 weeks after the Calibration is 
completed. 
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Create Config Log (System Description)
Revised: 11/16/2016 Topic(s): Admin; Diagnostics Doc ID:RBEH-AFRRC8 

A "Config Log" is a text file with a complete description of the hardware and software found in a currently 
running Cassini test system.  This file is useful for generating a Calibration Certificate or whenever the TIM 
module serial numbers and model numbers are needed, typically when debugging an issue. 

The file name is the GuruID followed by " Description.txt".  Send this file to support@roos.com along with the 
output of the Diag exec or prior to a RI run Calibration.

To create a Config Log:

Choose System > Tester from the main Cassini window.1.
Choose Tester > Create Config Log...2.
Change the destination to "D:\" or a shared network folder in the Save File dialog and send that file to 3.
support@roos.com.

Example File:



Create Config Log (System Description)(Cassini Maintenance Manual - )

Page 56

DE94BBXA Description.txtDE94BBXA Description.txt

The file includes the date the configuration was generated, Equipment Pool master Serial Number, Tester 
Title, Serial Number and Cal Set, Instruments by Name, Local Guru Setup including current User Name, 
Patches and Patches that are locked by the ShortCut with Cid.
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Diagnostic Test Plan Review
Revised: 07/26/2011 - 07/28/2017 Topic(s): Admin; Diagnostics Doc ID:RBEH-8K63FQ  (2 pages)

Diagnostic plans look for 
hardware problems in the 
test system. They are, in 
theory, independent of 
calibration. However, if 
the calibration is 
completely wrong, it can 
cause diagnostics to fail.

Note that the diagnostic 
list also includes verifies. 
This is to encourage you 
to run all the diagnostics 
and verifies before calling 
us for help.

Also note that the 
diagnostics do not stop 
on a fail.

Each TIM has a set of 
Diagnose and Verify 
testplans that are 
designed to identify problems with the specific configuration of TIMs.  A special interface 
fixture is required to perform the diagnose/verify testplans.

Note: This is not a complete list. The Diagnose list will vary depending on the tester 's 
configuration.

RI8581A_Verify Receiver: Checks the receiver's detectors and IF gains
RI8581A_Diagnose Rec Filters: Checks the bandwidth and rejection of filters in the 
receiver
RI8545B_Diagnose LNA IP3: Measures receive path IP3. Note: Most failures on this 
test are, in fact, path loss problems, not IP3 problems
RI8545B_Diagnose Noise Reference: Checks the internal noise reference
RI8545B_Diagnose Noise Source & 
RI8545B_Diagnose Noise Floor: Checks the noise source and the noise receive path. 
Note that these can fail if receive path has too much loss.
RI8545B_Diagnose Ports: Checks that signal is getting to the ports and that they are a 
good match
RI8545B_Diagnose Receive Attenuation: Checks the receive attenuator’s relative 
attenuation (receive attenuator is in the test head.)
RI8545B_Diagnose Relays: Checks that signal is getting to the ports and that they are a 
good match
RI8545B_Diagnose Switch F,G,H,I: Checks the coaxial switches in the test head for 
through loss and match
RI7725C_Diagnose Source1 & 2:Checks the sources produce RF properly
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RI8577A_Diagnose 1&2: Checks the source1/2 combiner's switches and attenuators
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Calibration of Test Fixtures
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8FWRKH (1 Page)

When are Fixtures Calibrated

Fixtures developed by RI are calibrated before they leave the RI facility and are good for 
the lifetime of the fixture.  RI's factory has the equipment, tools, and instruments to do 
the best job generating the calibration data.  Shipping the fixture adds very little stress to 
the fixture itself.  Actually, opening and closing the fixture flexes the cables and has 
more opportunity for offsetting the calibration than the shipment itself.

The only reason we would calibrate a fixture is if it had just been serviced and parts were 
replaced.

Here are some things to consider:

Removing the DUT board and replacing with it with the calibration boards provides a 
chance to have something go wrong.  The very act of calibrating a fixture exposes it 
to some danger of damage.

If something were damaged during shipment (unlikely unless the box is crushed) 
then calibrating it would actually HIDE the problem and make it far more difficult to 
find.  We ALWAYS diagnose the problem and fix it before we calibrate the fixture.

The idea of calibrating a fixture, or any instrument, "just in case" is not good 
methodology.  There is usually a small shift in the baseline of your measurements 
that can affect correlation and limits when you re-calibrate, even if everything is 
working perfectly.

RI strongly recommends measuring some known parts with your fixture before spending 
a lot of time calibrating it, or even validating it.  By cycling through the Calibration DUT 
boards, you will be exposing the fixture to the possibility of damage.  It just isn't a good 
idea to do that unless you have a positive indication to suspect the fixture is 
malfunctioning.
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Calibration Kit Maintenance for Cassini
Revised: 07/29/2011 - 07/28/2017 Topic(s): Admin; Test-plan Doc ID:RBEH-8K93EC  (3 pages)

To calibrate a Cassini, you must have a Interface Kit 
(8-Slot or 16-Slot) and Calibration Standards (20 
GHz or 40 GHz) appropriate for your configuration 
of TIMs.  The Interface Kit is included with delivery 
of a new Cassini system.  A CalKit must include a 
Power Meter and Sensor, Digital Volt meter, S 
Parameter Standards, Noise standard, Cables, RF 
Adapters, and RF Attenuators.

The Calibration kit needs to be calibrated regularly 
to NIST standards. The customer is responsible for 
setting the duration of the calibration interval and maintaining documentation.  The 
power meter/sensor and DMM are typically calibrated annually (every 12 months). The 
noise standard and OSL standards can be calibrated bi-annually (every 24 months). RI 
offers Cal Kit service as RIK0082A for 20 GHz cal kits.  RI usually issues a NIST 
traceable calibration certificate only when a preventive maintenance and calibration 
(PMC) is performed.  A calibration is performed when a major physical instrument is 
repaired or replaced, but a certificate is not always issued.

RIK Desciption
RIK0130A Cassini 8-Slot Interface Kit
RIK0149A Calibration Standards Kit, Cassini 18 GHz
RIK0150A Calibration Standards Kit, Cassini 40 GHz
RIK0151A Cassini 16-Slot Interface Kit

Each RI Cal Kit requires annual calibrations. If available, you can use a calibration lab at 
your facility or one in your local area. If not, some of the components may have to be 
sent to the manufacturer for calibration. Below is a listing of the Cal Kit components, 
Vendor Addresses and Web Sites. 
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CalKit Definition

The cal factors are stored in Guru as an "RiCalibrationKit" object class. If the cal kit was 
purchased, a RI USB stick with a '.gzp' file containing the new coefficients are included 
with the Kit. Be sure the new coefficients are imported with "Guru Browser" prior to using 
the Cal Kit.

Cal Kit Naming Convention: The RiCalKit Guru object has a Name that includes 
underscores "_" between the customer site name (RI), the serial numbers of the Noise 
Source (NS-#####)  serial number of OSL Box (OSL-######), and the last valid cal 
date in YYYY-MM-DD notation (2020-01-14),.  "RI_NS-12345_OSL-54321_2020-01-14"  
Before calibration, check that today is before the date and the serial numbers match, if 
not, the Cal Kit object needs to be modified (see instructions linked above).

Periodically, the cal kit coefficients may need to be changed.  To change the coefficients 
of a cal kit, use the following procedure:

From the Tester Configuration 
window select Instrument > 
Calibration > Inspect.   Only 
two contain entries that may 
change, "ENR" for 
NoiseSource, "Open" for the 
OSL. Change by double 
clicking the value on the right 
pane.  After selecting another 
entry, press OK to save 
changes.  Double-click the 
appropriate element. NOTE: 
Noise entries default to linear, 
always switch to log by 
selecting lin button. (see 
images below).  After all 
changes have been completed, select the Cal Kit entry in the Tester Configuration 
window, select Instrument > Calibration > Save to commit changes to Guru.
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Note: The lin/log button shows the current format, not the new desired format. When 
displaying in linear format, the button shows 'lin'. Clicking on the button changes to log 
format, and the button changes to 'log'.
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Cal Kit Vendor Information:  Please refer to the website for a vendor representative in 
your area.

Power Meter & Sensor
Gigatronics Inc.
4650 Norris Canyon Rd.
San Ramon, 
CA 94583-1320 USA
http://www.gigatronics.com/

DMM
Fluke Corporation
6920 Seaway Blvd.
Everett, 
WA 98203  USA
http://www.fluke.com/

S Parameters
Anritsu Company
490 Jarvis Dr.
Morgan Hill,
 CA 95037-2809  USA
http://www.anritsu.com/

Noise Source
NoiseCom
E. 64 Midland Ave.
Paramus,
NJ 07652  USA
http://www.NoiseCom.com/

Calibration Form

Fill in appropriate values for these entries each time the the RI Cal Kit is calibrated. Keep 
a copy of this form 
with the Cal Kit. Email this information to "support@roos.com".

Cal Kit Serial #_________________

Model Number Serial Number Cal Date Next Cal Due

DC Standard:

RF Power Meter:

RF Power Sensor:

Noise Source:

Open:

Short:

Load:
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Updating Coefficients of Standards used in a Cal Kit Definition on Cassini
Revised: 07/25/2011 - 03/04/2015 Topic(s): Admin; Diagnostics; Software Doc ID:RBEH-8K525N 

"CalKit" objects contain the coefficients of the Standards used during the Calibration 
process.  The calibration is INVALID if the values in the coefficients for the "Open" and the 
"Noise Source" are not correct.  Before you use a Cal Kit to perform a Calibration, confirm 
that the coefficients for the open and for the noise source are correct by Inspecting the 
values in the definitions and change them if they are different. Check the "Open" standard 
to confirm that it was entered correctly.  This only changes if the "Open" was damaged and 
re-calibrated. Check the Noise Source to check that it was entered correctly and has not 
changed. Every time the Noise Source is calibrated, its coefficients may change. This 
needs to be reflected in the CalKit definition.

CAUTION: Do not modify the coefficients unless they have changed or the serial numbers 
do not match.

The CalKit Naming Convention includes a descriptive name that matches the physical 
Box name (i.e. "ROOS CalKit #1") then the last valid cal date in YYYY-MM-DD notation 
(i.e. "2002-01-14") then the serial numbers of the Noise Source and OSL Box in this form 
NS_-#####-OSL-###### (i.e. "NS-22323_OSL-10100101").  Please continue using this 
naming convention to reduce the chance for errors selecting the wrong CalKit definition 
when performing a Calibration. For example: 
"ROOS_CalKit_2002-01-14_NS-22323_OSL-10100101" or 
"MILK_CalKit_2021-11-02_NS-12344_OSL-44003020"
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Load CalKit into Tester Definition

Start Cassini with the relevant Short Cut with a user with 
Maintenance role (See Guru Log-on Privilege Types).  Open the System 
Configuration window by pressing the 'System' then 'Tester' buttons. The CalKit is 
added from the Tester Configuration window or from the Calibration dialog.

Click on the "Instrument" menu, select "Add CalKit...", then select the appropriate 
Name.  
-or-
From the "Tester" menu, select "Calibrate".  From the Calibrations dialog, from the 
"Options" menu, select "Select Cal Kit"

To inspect/modify the Open, Short and Load:

Get the 'Open' coefficients from a printed 
Calibration Certificate (included in the bottom of the OSL box) or from a '.txt' file 
provided on a USB stick for Floppy disk(optional).  You can view the file from the drives 
icon by just double-clicking on the file. Verify that the file's serial number matches the 
serial number of the actual open.
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From the Configuration window, Right Mouse Button Click (RMBC) on the 'CalKit' 1.
instrument, select 'Calibration Inspect'. 
Double-click on 'Open'. You will see coefficient values for 'C0', 'C1', 'C2', and 'C3' in 2.
"e" notation. Verify that these match the corresponding coefficients from Open 
standard. If not, change them directly in the text entry field on the right.
Verify that the serial number in 'sn' matches the file's serial number and matches the 3.
serial number of the actual open. If not, change it. 
Close this panel.4.
For the short and load, the only thing to change is the serial number. Double-click on 5.
'Load'. Highlight 'sn'. Verify that it matches the serial number of the actual load. If 
not, change it. Close this panel. 
Repeat this process (step 5) for 'Short'.6.
Close the panels. If you have changed anything, RMBC on the CalKit instrument, 7.
from the "Calibration" menu, select 'Save'.  Use the CalKit Naming Convention 
mentioned above.

To inspect/modify the Noise Source:

Get the 'Noise Source' coefficients 
from the printed label on the side of the Noise Source. 

From the Configuration window, right mouse button click (RMBC), select 'Calibration 1.
Inspect'. Double-click on 'enr Table', then double-click on 'enr'.
There are normally 20 coefficients, corresponding to the 20 values on the noise 2.
source's label. Highlight '1'. Verify that the frequency is '10' (corresponding to the 10 
MHz coefficient on the noise source's label). 
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Select 'Power'. 3.
 ATTENTION! The power displayed is a linear number as shown by the 'lin' 
button (the button shows what the current format is). Click on the 'lin' button 
to change the format to log. The button should now show 'log'. 
Confirm that this number exactly matches the coefficient on the noise source's label. 
If not, change it and select 'OK'. 
Repeat this process for ALL the other coefficients, then close this panel.4.
Verify that the serial number in 'sn' matches the serial number of the noise source. If 5.
not, change it.
Close the panels. If you have changed anything, RMBC on the CalKit instrument, 6.
from the "Calibration" menu, select 'Save'.
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Guru Applications
Revised: 07/25/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8K4S9A  (2 pages)

The main RI file system Guru's user interface appears as a button bar along the right 

Guru

hand side of the desktop that list all the Apps that ship with the system and any Short 
Cuts that were defined by RI or later by a customer's Test Engineer.

The following Applications are available in a standard Guru enabled System 
Controller.  Access to these applications is controlled by the group membership (roles 
& permissions) of the user account.

System Launch Control "Guru Bar"

The "Guru Bar" provides access to Apps and Short Cuts based on the privileges of 
the logged on user.  The System button allows Logoff, Shutdown (restart), replicate 
(send to backup guru), synchronize (pull all owned objects from update guru), and the 
Message window (activity log).
Cassini (Short Cuts)

The operating environment for any the "Cassini" style ATE systems is found here.  The System 
button menu is used to update the tester when the hardware has changed, access the message 
log window, and exit the ATE System operating software. The Test menu provides access to the 
Plans, Package Execs, Testers, Devices, Device Interfaces, and Fixtures. The Import menu 
provides a way to quickly import files into Guru. 

Device Control Editor

This application defines how the device is controlled (Serial, Parallel, etc.) 
User Guide: http://roos.com/docs/ECHN-77TMFS?Open

Device Connection Editor
This application creates and edits Fixtures, Device Interfaces (DIB), and Devices.
User Guide: http://roos.com/docs/ECHN-7MDQBU?Open

GuruAgent

The GuruAgent application runs Guru Agents ( similar to commands or batch files ) that perform 
various activities at a scheduled interval.  Typical activities include exporting test data to STDF to 
a network drive or FTP server, run system backups, etc.  Guru Agents can be configured to Run 
automatically and run in the background without any user interface.  See the Guru Agent Editor 
application for more information (User Guide).

GuruAgentEditor

The GuruAgentEditor application provides an editor that allows users to modify the specific tasks 
and schedules of Guru Agents.
User Guide: http://roos.com/docs/ECHN-72ZPBR?Open

Guru Browser

The Guru Browser application allows direct browsing and editing of the entire list of files 
contained in Guru as Guru Objects.

User Guide: http://roos.com/docs/ECHN-6YTU6H?Open

Guru Address Book Admin

The Guru Address Admin application is used to define connections to multiple Guru Servers.

User Guide: http://roos.com/docs/RBEH-8JWQN4?Open

Guru Users Admin

The Guru Users Admin application is used to create and modify user accounts.  The following 
Users are created in default installation: <company name>, Engineer, Operator, Guest

User Guide: http://roos.com/docs/RBEH-6DCPWP?Open
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Update Manager

RI's revision control manager allows building and editing of "Short Cut" objects that contain the 
instructions to build a specific software version.  Every time a software update is issued, a new 
short cut should be created so operational released Test plans do not need to be revalidated!

User Guide: http://roos.com/docs/ECHN-867Q7E?Open
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Import Cal Data .GZP with Guru Browser
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-AEGP8B  (8 pages)

The Guru Browser application allows you to import Cal Data (.gzp) into Guru prior to installing a TIM that 
requires it.

Roos Support will email the site contact CalData just after sending any TIM via the RMA process or when 
purchased as new.

 After logging on to Guru, click the Apps then select Guru Browser.

Importing a Guru Object

To import a Guru zip file xxx.gzp that includes Guru objects, use the Guru Browser application, click the 
Guru Import List page of the Guru Browser window.
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Click on the Get Import File(s) button to select which file to import the Guru objects to the local Guru.

Select the directory and filename which you placed the imported file, then click on the Import button.  
Wait while the objects are compared to what is already in Guru.
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IMPORTANT: Now press the "Import" button, when the process is finished, you have the Guru object(s) 
in your Guru.

After installing the TIM, follow the procedure for "Checking For Valid Calibration Data" (Cassini Reference 
Guide, CH7: Troubleshooting, Section 6: Checking for Valid Calibration Data, pg 489) to confirm the valid 
Cal data is loaded.

To inspect the Instrument’s Calibration Date and Time:
Open the Tester Configuration window by choosing System > Tester from the Cassini main system 1.
window.
Select any Instrument, RMB click and choose Calibration > Restore. Confirm by pressing OK 2.
button, even though we will NOT be changing the Cal Data. The Date and Time at the bottom of the 
list represents the currently loaded Cal data.
Choose cancel to close the window without affecting the Cal Data. If select was pressed, a new Cal 3.
Data entry will appear with the current date and time. Data is never deleted, only saved as the most 
recent.
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Connect to Guru Server with Guru Address Book
Revised: 04/18/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8G32X2  (6 pages)

The Guru Address Book Admin application allows you to create and update Guru Server network addresses 
which are used to connect Guru Clients (the Cassini System Controller or Virtual Workstation) to a Guru 
server. After logging on to Guru, click the Apps button, then select the Guru Address Book Admin.  The 
username must have "Admin" privileges to see the Address Book application.

Once the Guru Address Book Admin application comes up, you can create a new or update an existing guru 
address.
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Creating a New Guru Address

Select New Remote Address button.
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Enter the Name  for this Guru address, for example, 'Update01'.  Enter the static IP Address of the Guru 
which you want to connect to in the Address  field.  The Port  field should be specified as 50000 .

The Address Type field, for now, simply choose either backup  or update .  The "backup" type indicates you 
want to have all of your local objects stored for later retrieval. The "update" type is reserved for servers that 
you want to check on the fly for updates, so it should be located on your local network.

When done specifying all the fields, click the Save button.  You can add as many Guru addresses as 
needed.  When done with adding the Guru address(es), you will need to shutdown the RI Guru process and 
restart it.

To shutdown the RI Guru process, click the System button of the RI Guru window.  Click the Shutdown 
button to shutdown the RI Guru process and the RI Guru will restart automatically.
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Updating an Existing Guru Address

Select the Guru address which you want to update, then click the Edit Selected button.
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Update all the fields which you want to change, then click the Save button.

When done specifying all the fields, click the Save button.  You can add as many Guru addresses as 
needed.  When done with adding the Guru address(es), you will need to shutdown the RI Guru process and 
restart it following the same procedure as above.
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Removing an Existing Guru Address

Select the Guru address which you want to remove, then click the Delete Selected button.

Click the OK button if you really want to remove the selected Guru address(es).  You can click the Cancel 
button to abort the deletion process. When done removing the unwanted Guru address(es), you will need to 
shutdown the RI Guru process and restart it.
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Transferring Test Data with Guru Agents
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin; Software Doc ID:RBEH-8FWVCY  (6 pages)

1.0 Introduction

Guru Agent Editor is a tool used to create configuration files for Guru Agents.  Guru Agents are used to 
perform various types of automated functions including: Copy, Delete, Admin, and Print.  This document 
describes, primarily, the ‘Copy’ and the ‘Stdf Copy’ Guru Agents.

The Copy Guru Agent is used to perform automatic copying of files. It can perform automated copy functions 
from one Guru to another, from a Guru to a file system, or from a Guru to designated FTP locations. In 
addition, it can do so at regularly programmed intervals, and it can be manually executed.

A Guru Copy Agent can operate on multiple sources as well as multiple destinations.  Each can specify the 
type and location of the source or destination as well as any additional parameters, such as proxies, to allow 
the connection to navigate firewalls etc.

2.0  File Copy Guru Agent

2.1  Overview

This section describes the editor used to configure agents that perform the file copy function.

The above figure shows the Guru Agent Editor application.  On the left half are the data sources in a set of 
tabbed panes, the right contains data destination.

In addition, there are pull down menus, found at the top of the program, that allow for configuring a Guru 
Agent, loading and saving of settings as well as adding and removing of data sources and destinations.

2.2  Using The Guru Agent Editor

2.2.1  Opening a File For Editing

Loading a file for editing is accomplished by selecting the pull down menu: File > Open. This presents a 
dialog box such as shown below, with a list of available Guru Agent setting files for editing. Select a file, and 
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then select the “OK” button. Pressing the “Select Type” button allows for the selection of different types of 
files to be displayed, this can be useful if a GuruAgent settings file has been saved as a different type (or 
object class).

Similarly, selecting File > Save or File > SaveAs causes a file to be saved back to Guru. Save overwrites 
the previous file; SaveAs causes the creation of a new file, thus preserving the old one. Note that in either 
case, previous versions are always retrievable using the Guru “History” feature.
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2.2.3  Settings

The Settings pull down menu has three categories of settings: Execution, Appearance and Messages/Errors. 
These are settings that control how the Guru Agent will run, when it will run as well as how often.

2.2.3.1  Execution Settings

The pull down menu Settings > Execution displays a dialog such as the one shown below.

The Execution settings control what type of copying will occur, how often the agent will run as well as 
whether it runs automatically at the specified rate (auto type), only at Guru startup (startup type), or only 
when manually executed, such as from the Guru App selection button (Manual type).

Note: The selections “Regular Copy Agent” versus “STDF Copy Agent” refer to the manner in which 
source files are selected for copying. The primary difference is that selecting “STDF Copy Agent” causes 
the pieces of the STDF file to be assembled prior to being copied. For non-STDF file, the “Regular Copy 
Agent” selection should be used.
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2.2.3.2  Appearance Settings

The Appearance dialog box is displayed by selecting the Settings > Appearance pull down menu.

It allows setting parameters such as whether a visible window is displayed while the agent is running 
(normally this is de-selected). In addition, provides the option to allow the window to automatically close after 
the agent finishes running (this is the default case).

Sometimes it can be useful to allow the agent to keep running, after it has finished its task, for debugging 
purposes. Note that if Auto Close is not selected, the agent will not automatically terminate after it completes 
its task. As a result, the agent will not automatically run again until after the agent has been manually 
terminated.

The settings for “Screen Location” and “Screen Size” rarely need to be modified but are provided as a 
convenience to the user.

2.2.3.3  Messages/Errors

The Messages/Errors dialog box can be displayed by selecting the pull down menu: Settings | 
Messages/Errors. It allows the user to select the types of errors that will be logged by the agent as it runs. 
There are four choices available:

    0: No Logging of any sort

    1: Logging only errors. For example: Couldn’t find destination directory

    2: Log Non-Errors as well as Errors. This includes lists of files that were successfully copied, and so on.

    3: Debug Mode Logging. This enables logging of internal program events that are normally not of interest 
to most users.
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2.3  Source Settings

The left area of the main application window represents the ‘Source’ information.  This defines what needs to 
be copied and where it can be found.  There can be one source or many sources. In order to add more 
sources, click on the Edit > Add Source pull-down menu; this causes a new data source being displayed 
(for example, 'source1', 'source2', etc.).  You can add as many sources as desired.  Delete a source by first 
selecting it (so that it is displayed) and then select Edit > Del Source.

The field Match On defines the Guru keys that are used to fetch pertinent data.  What is entered here is a 
comma separated list of keys, or key=value pairs, that uniquely identify the data that is to be fetched.  For 
example: ‘ri.sys.ObjClass=RiAdminLog’.  This would cause any file, in the source location, that had that 
particular key/value pair, to be included in the group of files to be copied.

Note: When using the agent to assemble STDF or ATDF data logs, the Match On selection string should 
include "ri.sys.ObjClass=RiTestData,ri.sys.Type=summary"

The Type selection:  currently only Guru Sources are allowed, therefore the selection box only allows for 
source selection of type ‘guru’.

The Location field specifies where the source is located.  Legal entries here are either the word ‘local’ which 
implies that the ‘Local Guru’ is to be the source for the data. Or else any IP address or URL can be specified.  
An example would be ‘www.roos.com’.  In addition to the IP address or URL, a colon and port number is 
optional, for situations where a non-standard Guru port is being accessed. For example: 192.168.1.123:5000
0.

Proxy Info allows for a proxy to be used as a means of accessing the Source location. A proxy can be either 
in the form of an HTTP proxy, a socks 4 or socks 5 proxy. Clicking on the Proxy Info field will bring up a 
dialog that allows selection of the type of proxy as well as the relevant required information e.g. hostname, 
proxy port address, proxy username and password (if needed).

Copied Files Tag: This field defines a key that will be set after the copy operation is successfully completed.  
This is used in conjunction with the check box: “Ignore Copied Files”, to keep from re-copying files that have 
already been copied.

Ignore Copied Files: This check box works in conjunction with the “Copied Files” entry. The default state is 
for this to be selected. If selected then any files that have already been copied, won’t be copied again. 
De-selecting this will cause files to be copied; even if they have already been previously copied.

Ignore Invalid Files: Occasionally a corrupt or invalid file may find its way into the file system. If a file is 
determined to be corrupt, incomplete or otherwise invalid, it automatically gets tagged as such. The default 
setting for this check box is that it be selected; this results in invalid files being ignored. De-selecting 
(un-checking) this check box will result in the agent re-attempting to gather and copy those invalid files. Note 
that this is primarily related to the STDF files option as they are pieced together from separate files.
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2.4  Destination Settings

The area on the right hand side of the main application window represents the ‘Destinations’. This defines 
where files will be copied as well as their final names.  There can be one destination or many destinations. In 
order to add more destinations, click on the Edit > Add Destination pull-down menu; this causes a new 
Data Destination to appear in the right hand area of the application, as a tabbed pane.  As many destination 
as desired can be added.  Delete a destination by first selecting it (so that it is displayed) and then select 
Edit > Del Destination.

The Type field can be any of three possible values: ‘guru’, ‘ftp’, or ‘file’. This identifies the type of destination 
being defined.  

‘guru’ causes source files to be copied to the specified destination Guru.

‘ftp’ causes an FTP connection to be opened using the specified values for Connect info, Location, 

Rename Template and Proxy Info.
‘file’ type will cause the data to be copied to a file system location using the specified values for 

Connect info, Location, Rename Template and Proxy Info are use.

The remaining fields will display if needed for the different destination type as described below.

The Location field describes either the IP address, ftp location or file system location to connect to when 
copying files to this destination.  Valid entries here would be an IP address or URL followed by an optional 
port number, or else a valid file pathname.

The Rename Template is used to automatically create filenames from guru keys.  Within guru, files are 
specified by sets of key=value pairs.  Oftentimes these files have no useful filename that can be used to 
distinguish one file from another once copied to an ftp or file system location. This field allows a name to be 
automatically created from guru keys.  Basically any text can be entered here, in addition any value in angle 
brackets ‘<’ ‘>’ is treated as the name of a guru key. For example:

#
Date1<ri.dlog.StartTime>_<ri.dlog.Lot>_<inx.dlog.TestMode>_<inx.dlog.TestType>_<ri.dlog.Tester>_<ri.dlo
g.Testplan>.std
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Backup System with Guru
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8FWVD2 (1 Page)

Automatic System Backups with Guru Server

A Guru Server configured as a Backup Guru provides automatic backup of all data and 
applications that are launched from the local Guru.  See the training topic "Connect to a Guru 
Server with Guru Address Book" for specific instruction.  All Guru applications save every revision 
of every file to their local Guru.  When the Guru periodically connects to a configured Backup Guru, 
it transfers all of the revisions to the Guru Server.  If the connection is interrupted, click System | 
Synchronize from the Guru bar to force the Guru Client to upload all changes to the Backup Guru 
and get all the updates from the Update Guru.

Restore a System Controller with Guru Server

The System Controller can be quickly and automatically restored by attaching the USB Guru Key to 
the new System Controller and verifying that the Guru Server is set as the "Update Guru" using the 
Guru Address Book.  Once the user logs on, all applications will automatically load the needed 
objects from the Guru Server on demand.  It is recommended to use the System | Replicate 
command to move all the necessary objects to the local Guru to improve performance.  After 
performing a System Restore, use System | Shutdown button from the Guru bar to restart Guru to 
load the most recent changes.

Restore Previous Version

To restore a file from a local Guru or a Guru Server, follow the instructions for Recovering a Guru 
Object.
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FTP Corrupted File? Use Binary Type Tansfer Mode.
Revised: 09/29/2014 Topic(s): Admin; Software Doc ID:RBEH-9PEQU5 

GZP Files can be corrupted when transferred with FTP command.  (This can affect any file type.)  The 
problem can be resolved on the client or server.  The client can be changed into "binary mode" or the 
server can be set to "ignore ASCII mode".  NEVER USE "ASCII" MODE.

The problem is that the file is being translated by the server when transferred in "ASCII" type/mode.  
ASCII type transfer mode converts "newline" (EOL) codes in a file to match the platform of the target.  (
Doc explaining ASCII vs Binary)  This was really handy a very long time ago, but now it just corrupts files.  
Unfortunately, the FTP command line client defaults to "ASCII" mode, so you have to switch modes with 
the "binary" command every time after connecting to a server.  IMPORTANT: YOU HAVE TO DO THIS 
EVERY TIME!

FTP Server fix:  FileZilla is a free Windows FTP server that does NOT corrupt files when transferred in 
ASCII type mode.  (and there are plenty of others for every platoform)

There are 3 ways to FTP a file from the system controller: 
FTP command1.
FTP-PM (graphical)2.
FireFTP (Firefox Addon).  3.

FireFTP Firefox addon is the best and defaults to Auto and will use binary for .gzp files. The command 
line is preferred for simple transfers (but remember to switch to binary mode).  Most FTP servers can 
ignore ASCII mode, this is also the best way to prevent corruptions.  

FireFTP Firefox addon.  See Install FTP Client on System Controller (or Virtual Workstation)... for 
installation and use.  Defaults to binary mode.

FTP command client:
Start a OS/2 command window, navigate to the folder containing the file to transfer ("cd d:") and then 
type "ftp <hostname>", then "binary" to switch transfer mode, then "put <filename>".

From a FTP command prompt, check the transfer mode with the STATUS command, it should say 
something similar to:

Connected to <servername>.
No proxy connection.
Mode: stream; Type: binary; Form: non-print; Structure: file
Verbose: on; Bell: off; Prompting: on; Globbing: on
Store unique: off; Receive unique: off
Case: off; CR stripping: on
Ntrans: off
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Nmap: off
Hash mark printing: off; Use of PORT cmds: on

FTP-PM - A graphical FTP client launched from eCS > Desktop > Internet > Internet Utilities > FTP-PM.  
It's a little slow. 

Choose Options > Transfer Mode > Binary. (Transfer Mode appears in lower right hand corner)
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Exporting STDF via Guru Agent for a second time
Revised: 02/19/2015 - 01/24/2017 Topic(s): Admin; Software Doc ID:RBEH-9TVRME 

If you have a file, such as STDF data, that has been copied by the agent and you wish to copy it 
again, you have three options:

Option A. Tell the agent not to ignore already copied files.

Instructions: 
1. Open Guru Agent Editor.
2. Use the Guru | Open pull-down menu to select the appropriate agent file.
3. Click on the check box (near the upper left) labeled “Ignore Already Copied Files”.
4. Save the updated setting using the Guru | Save pull-down menu.
5. Run the Agent, causing ALL previously copied files to be recopied.
6. Don’t forget to restore the setting afterwards to prevent the agent from re-copying the 

files every time going forward.
Note: this will cause all previously copied files for that agent file, to be recopied. Be careful when 
using this approach, it can result in an quite a few files being copied.

Option B. Change the value that indicates a file has already been copied. You can change the 
marker value that indicates a set of files have already been copied, essentially ‘starting over’ 
with those files.

Instructions:
1. Open Guru Agent Editor.
2. Use the Guru | Open pull-down menu to select the appropriate agent file.
3. Change the value in the field labeled On Successful Copy (located near the lower left). 

Change the value to anything else, for example from“local.ri.sys.GA_Copied=true” to 
“local.ri.sys.GA_Copied2=true” instead. Note: be sure the new one still starts with 
“local.”. 

4. Save the updated setting using the Guru | Save pull-down menu.
5. Run the Agent, causing ALL previously copied files to be recopied and to be tagged with 

the new indicator going forward.

Option C. Clear the “already copied” indicator from a single data file. You can clear the 
indication that a file has been copied by editing the file attributes, removing the marker.

Instructions:
1. Open Guru Explorer.
2. Select the data file to be recopied. One way to do this is by selecting 

ObjClass=RiDatalog (using the 'Key 1' box on the left hand side). Click on the 
“Creation Date” column to show the latest entries at the top. Note: When doing this with 
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STDF data, there may be numerous entries comprising a given data file, but the only 
one that needs to be edited is the summary file. It is tagged with the field 
“ri.sys.Type=summary” (note that the 'Key 2' box on the left hand side can be used to 
display only entries meeting that criteria).

3. When the appropriate datalog file has been found, click on it to select it, then right click 
and choose “Edit | Attributes”.

4. In the edit panel, delete the line containing the entry “local.ri.sys.GA_Copied=true”.
5. Use File | Save in the pull-down menu to save the changes back to Guru.

Now that the 'already copied' indication is cleared, it will be copied the next time the agent runs.
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Restore, Sync, and Log System Controller with System
Revised: 04/14/2011 - 07/28/2017 Topic(s): R&D; Software Doc ID:RBEH-8FWVCZ  (2 pages)

Guru provides buttons to perform some administration tasks from a System button window.  A user must 
log-on to Guru and have administration rights prior performing any of the administration tasks.

Once you've logged on to Guru successfully, the Logon button changes to System button.

Click the System button to bring up the System  button window.

Click the Logoff button to log-off from Guru.  You must log-off from Guru to log-on as a 
different user.

Click the Shutdown button to shutdown the Guru.  Guru will restart automatically.

Click the Replicate (Restore) button to restore local Guru.  This restores local Guru 
objects from a backup Guru.  This feature will only work if you have a Update Guru 
Server properly configured with the Guru Address Book application.

Click the Synchronize button to synchronize local and update Guru.  This feature 
checks the local and update Gurus and updates all objects on the local Guru with the 
latest version from update Guru.  This feature will only work if you have a Guru Server 
properly configured.  Note: The guru objects automatically sync (get the latest version) 
every time it is loaded.  This button is helpful for speeding up this process after the 
system has been disconnected for a very long time.

Click the Message button to see messages between Guru and Guru based applications.  
This is useful for debugging purposes.  When you click this button, a Logged Events 
Window will be displayed.

Click the Cancel button to dismiss the System button window.

LOGGED EVENTS WINDOW

When you click the System > Message menu, a Logged Events window will be displayed.  The Logged 
Events window displays messages being sent between Guru and Guru based applications.
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Severity is either 1, 3, or 5.  When a different severity level is selected and the Refresh button is clicked, the 
list will be updated with all messages with the selected severity and lower.  For example, if severity of 1 is 
selected, it will only display messages with severity of 1; if severity of 5 is selected, it will display messages 
with severity of 5 and lower.

Level is between 0 and 9. First select a specific Level, click the Refresh button, and the list will be updated 
with all messages with selected level and lower.  For example, if level of 0 is selected, it will only display 
messages with level of 0; if level of 7 is selected, it will display messages with level of 7 and lower.

To change the order of the display, select Newest first or Oldest first, and click the Refresh button.

To clear all the messages being displayed, click the Clear button.

To close the Logged Events Window, click the Close button.
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Monitor Error and Warning Messages
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8FWVD4 (1 Page)

RI Software Message Window "Log File"

The RI System Software presents warning and error messages to this separate "log file" window that 
acts as the console for the RI System Software.  Unlike the Cassini message window, this does not turn 
yellow when in Simulation Mode.

This can be accessed by pressing the SYSTEM button on the Guru bar and then the MESSAGE button.
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Troubleshooting - Cassini System Hardware
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-6XGV4D  (6 pages)

This general procedural document is to be used in the diagnoses and communication of system problems.
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To Contact RI: support@roos.com, +1-408-748-8589
Provide Serial Number of the Cassini system and related TIMs and steps to recreate the issue.



Troubleshooting - Cassini System Hardware(Cassini Maintenance Manual - )

Page 94

Handler Issues

 

The Hander Pod is configured at the factory and its configuration stored on the device itself.  Hander Pods 
are available with different interface options: Parallel (RI8517A), Serial (RI8516A), or GPIB (RI8552A).  
Handler issues are generally resolved by checking the connection between the handler and the RI ATE 
System or a re-configuring the handler.  A ground wire may be necessary between the test system and 
the handler to prevent power spikes that the handler or tester misreads as a signal.

In the case of irregular handler operation, first check the RIFL cable that goes from the Handler Pod to the 
Handler's tester interface connection for kinks or damages.  Make sure that the cable is NOT a standard 
RJ-45 ethernet cable, it must have shielding.  Most handlers have an opto-isolator built into the tester 
interface that needs to be connected to Tester power through the interface cable.  Use a volt meter to 
verify that the required voltages are present and that all the connections are made.

Make sure the Handler and System are grounded to the same earth ground (same AC outlet) so that no 
ground potential exists between the Handler and Tester.  If there is a possibility of ground potential, 
connect a 16 gauge or higher ground wire from the Handler Chassis to the System's rack.

To test a Handler Interface Pod, connect the pod using the supplied RIFL III cable to the connector on the 
Testhead and the handler to the pod with your custom handler cable.

From Cassini "System" button, select “Equip” to open the Equipment Pool window.

From Equipment Pool window, select “Nodes”, then from the "Pool" menu, select ”Control Modules” to 
open the Module Browser window.

In the Module Browser window, in the left section find and highlight the Handler Interface Module 
“XXXXXXXX Name” (Name would be the name of the handler, "Delta" for example). In the middle section 
highlight “Handler”. In the lower section there are 3 boxes in the lower left.  These will be used to control 
the Handler pod signals and provide a way to test the control logic with the Handler attached.
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Hander Pod Interface Troubleshooting

If you do not have a RI Monitor Handler Interface (M6XHRF1A), you can check bins 1 
and 2: 

Send a Bin and EOT signal to the handler by selecting the box marked “PULSE 1.
BIN”.  
In the “Choose” window, select a Bin (1 or 2).  2.
The Bin and EOT lights should flash.3.

If you have a RI Monitor Handler Interface (M6XHRF1A ), you can check bins:
Connect the Monitor Handler Interface. 1.
Send a Bin and EOT signal to the handler by selecting the box marked “PULSE 2.
BIN”. 
In the “Choose” window, select a Bin. 3.
Watch for the Bin and EOT lights flash on the Monitor Handler Interface (and on 4.
the handler pod for bins 1 and 2).

If you have a means of sending a start signal to the handler pod, you can test if the 
handler is sending a start test signal to the ROOS system use the box marked 
“WAITFORSTART”.  To use this feature click on the box. In the “Choose” window, select 
a Bin.  This Bin number will be sent from the ROOS tester to the handler after the 
handler pod receives a start test from the handler.  Enter 1 for “How many to run”.  The 
ROOS system will now display in the main message window “waiting for start” and wait 
for a start of test signal from the handler.  When the ROOS receives a start of test signal 
it will send the selected Bin and EOT to the handler.
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Hander Pod Interface Troubleshooting

Connections for RI8503A0 Handler interface

25 Pin Female D Sub type

Connection Function Circuit type

Pin1 Bin1 Open Collector Output
Pin2 Bin2 Open Collector Output
Pin3 Bin3 Open Collector Output
Pin4 Bin4 Open Collector Output
Pin5 Bin5 Open Collector Output
Pin6 Bin6 Open Collector Output
Pin7 Bin7 Open Collector Output
Pin8 Bin8 Open Collector Output
Pin10 Start Test TTL Input
Pin11 +V(H) Handler +V for Pull Up   (SEE 
NOTE 1)
Pin12 GND Ground
Pin13 +5V System +5V
Pin14 On RI8503A0 is +5V System +5V
Pin15 Input2 Misc. TTL Input, not used
Pin16 Input3 Misc. TTL Input, not used
Pin17 Input4 Misc. TTL Input, not used
Pin22 Bin9 Open Collector Output
Pin23 Bin10 Open Collector Output
Pin24 Bin11 Open Collector Output
Pin25 EOT Open Collector Output

NOTE 1.   Pin 11 MUST EITHER be connected to the +V from the handler or Pin 13(or 
Pin 14)
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Fixture Issues
Auto-detection depends on serial number

Fixture and DUT I/F have serial chip

If both are new, Fixture must be "identified" before DIB

Connector Hygiene

A RI Test Fixture typically has a serial ID stored as embedded flash that has a unique serial number that 
comes pre-programmed from the factory.  The RI System Software reads this ID on system Startup and 
will attempt to locate a Test Fixture software file that matches that ID.  If a Test Fixture file is found the RI 
Software will activate that Test Fixture File.  From the Cassini window, use "System | Check" buttons to 
scan the devices (including Fixures, DIBs).

The RI System Software has the same auto detect feature with the Device Interface Board (DIB) and can 
locate a specific Device Interface Board calibration and configurations based on the ID read from the 
physical DIB serial ID.  

The Test Exe will check if the current Test Plan is able to use the active Test Fixture and Device Interface 
and give a warning message if there is not a match for either.  

It is a good idea to always visually inspect the Test Fixture connectors prior to loading on the Testhead 
looking for damaged pins or contamination (dust or debris).
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GPIB Instrument Issues
GPIB cable length limit (4 Meters)

Don't extend GPIB cables to make a longer run

Instrument made "inactive" if it fails at Startup

GPIB instruments must have a unique address

GPIB address must match stored address in Tester software object

If there are any non-RI instruments that have been added to the RI ATE System that are controlled 
through the general purpose GPIB bus, then an inspection of the connections should be routinely made.  
These types of instruments have a tendency to be a shared resource and therefore the probability of an 
error being introduced is greater every time the instrument is reconnected. When a GPIB instrument is 
selected to be available to the system, a system startup should be executed to check if the instrument is 
connected correctly and it's GPIB address is correct.  If there is any issue with the GPIB programming of 
the instrument, it will be marked "Inactive" and a warning message will be placed in the Message Window.  

If there is a GPIB issue always check:

The GPIB Address

That there is no "Daisy Chain" of the GPIB Cables

The correct driver was selected
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Troubleshooting - Cassini System Software
Revised: 07/12/2012 - 07/28/2017 Topic(s): Admin; Guru Help; Software Doc ID:RBEH-8W5N73  (3 pages)

System Controller (EPC) Issues

Startup Failure?  Access Recovery Menu
("ALT+F2" to enter recovery menu)

Press "1" to restore desktop (restore factory UI, all guru Apps settings 
preserved!)

Press "F2" to enter command prompt

TIM swap for hardware failure (including HDD)

Always contact the factory (support@roos.com) to report following this procedure.  You may be instructed 
to enter the command line and given specific instructions on what to change.

If the system controller (EPC) fails to load, press ALT+F2, then press "1" to restart from the Factory 
configured Archive.  

TIP!  THIS DOES NOT AFFECT ANY TEST DATA OR GURU SETTINGS !

There are two function key combinations that can be activated while the white blob appears on the screen 
followed by the word OS/2. These are Alt-F1 which will interrupt the boot process and take you to a 
recovery menu, and Alt-F2 which will continue the boot while displaying the name of each device driver as 
it is loaded to help identify the driver causing problems.

The recovery menu that comes up when you press Alt-F1 contains a number of options to help you in 
getting your system to start although in some cases your system may not be recovered by these as well 
as you might like. Options contained in this menu include:

ESC to continue with the normal boot process

1, 2, or 3 to restart from one of the last three archives that you created.

F2 to boot to a command line without starting the graphical interface. From here you can run 

MAKEINI to rebuild your desktop or use TEDIT (a small command line editor) to fix corrupted 
files.
F3 to reset the video mode back to VGA, bypassing the installed graphics driver. A useful option if 

your video driver gets corrupted or you set it up incorrectly.
F4 to restart the system with a maintenance desktop. From here you can use the selective 

reinstall option to rebuild the corrupted part of your system.
F5 enables FULL hardware detection.

F6 disables hardware detection. This is useful if you have problems with plug and play adapters.

0 recovers from the original archive of your system setup that was taken when your system was 

first installed.
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Guru Server (VM or Linux) Issues

Reload Guru: From "Guru bar" select System | Shutdown...

Guru Server ("startApp.sh" and "es" process)

Kill process: "ps -A | grep es" to see PID, "kill -p <PID>" for each PID

ATTENTION!  ALWAYS contact ROOS Support prior to attempting any of the following troubleshooting 
steps.  

The Guru Server runs on a Virtual Machine or native Linux server.  A dedicated user "riguru" should be 
created on the host OS, the program is installed in the "$HOME/RiApps" directory or "~/RiApps/" folder 
and data stored in "~/RiGuru/" folder.  

The process is launched by a "startApp.sh" that should be added to the GUI's desktop (KDE or Gnome) 
standard auto-start location.  Note: A GUI is required, Guru Server can not launch "headless" (this may 
change in future versions).

When Guru starts, the program files are always copied fresh from the "guruServer.zip" container and then 
launched.  This step assures consistency and prevents any random HDD read or write errors related to 
aging from interfering with the program launch.  If the script fails to properly unpack the program from the 
guruServer.zip file, the script launches the version that remains on the disk.

To prevent Guru from restarting, kill the "startApp.sh" process.  Normally the Guru Server application 
automatically restarts when "System | Shutdown" button is pressed.  This prevents the service from being 
inadvertently shutdown.

If the guru server is unresponsive or needs to be stopped for any reason, you can open a command 
window as root and issue "ps -A | grep es" command to see the process ID (PID) of the guru server.  
Force the process to stop with "kill -p <PID>" for each process identified.  If the problem persists after a 
restart, copy "guruServer.zip" from a know working backup.  If the problem continues, try restarting the 
host OS.  Some OS upgrades may remove or relocate critical system files and may require a symlink ("ln 
-s /path/to/file") to be created to maintain backward compatibility.

If a walkback occurs, select "SAVE" from the dialog box and send the error log (~/RiApps/vterror.log) to 
support@roos.com.
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Guru Client (System Controller) Issues

Reload Guru: From "Guru bar" select System | Shutdown...

If Guru Client hangs: CTRL+ESC, select "Guru" window, hit DEL

Still not responding? CTRL+ALT+DEL, TOP, "guruServer" process

ATTENTION!  ALWAYS contact ROOS Support prior to attempting any of the following troubleshooting 
steps.  

The Guru client runs on the RI System Controller powered by eComStation (OS/2).  No user accounts are 
required on the host OS.  The program is installed on "D:\RiApps" and the data directory is "D:\RiGuru".

The process is launched by the Local System | Startup folder as "RI Guru" (or similar).  

When Guru starts, the program files are always copied fresh from the "guruServer.zip" container and then 
launched.  This step assures consistency and prevents any random HDD read or write errors related to 
aging from interfering with the program launch.  If guruServer.zip is corrupted, the program will eventually 
attempt to launch the previous unpacked version.
  
To prevent Guru from restarting, kill the "Guru Server Startup" process.  The Guru Server application 
automatically restarts when "Shutdown", this is how Guru is automatically upgraded and prevents the 
service from being inadvertently shutdown. The Guru Client application will automatically restart when 
Shutdown, this is to prevent users from accidentally closing Guru.  
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Troubleshooting - Breakpoint & Control
Revised: 07/25/2011 - 07/28/2017 Topic(s): Admin; Diagnostics Doc ID:RBEH-8K54HA  (4 pages)

Most Test Instrument Module (TIM) problems are diagnosed by inspecting Calibration 
Data, setting breakpoints, then directly controlling the system for the suspected 
instrument.

From the main window, tap System > Tester.  Then select desired instrument.  (Note: 
one or more software instruments may be contained in a single TIM)
Instrument > Calibration > Inspect

Never edit Calibration data unless specifically Instructed by RI . You can get the test 
system into a state where it won’t even start up.

Set Break Points

‘Options’ ‘Set Break Point’
Changes color at the break point
Can only break on a test, not on defaults etc.
Test plan will stop after setting up the hardware and taking the measurements
Only 1 break point per test plan
You can continue, single-step, abort, or open the control panel

Note: Do not do a system start-up while at a break 
point
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Control Panel

‘Options’ ‘Control’
         or
From Breakpoint

If reached from a breakpoint, reflects the settings at the breakpoint. Remember that 
the Testhead is ‘hot’ at this point.

Manually control system instruments
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Disabling Parts of Test Sections

Disable parts of tests to increase speed or decrease confusion
Programmer message window will always say ‘Fail’ if any test or test section
 is disabled
‘Edit’ ‘Disable/Enable’
   ‘Selected’
        or
  ‘Disable All
then re-enable selected

There are a couple of reasons you might need to disable parts of a test during debug. 
One is to increase the speed of a testplan. Disabling one of the many tests or test 
sections of the testplan will make it run faster since there are now fewer tests being run. 
This is particularly useful when doing a ‘rattle’ test. Another reason is to decrease 
confusion. If you are troubleshooting a problem, by disabling a test or test section, it will 
decrease the amount of data that you have to sift through while searching for a solution.

To disable a test, first click on the test you want disabled. Then, at the top of the testplan 
window, select ‘edit’, ‘disable/enable selected’. This will disable the slected test. If you 
want to disable more than one test in a section, repeat the process, then select ‘disable 
all’. This will disable all the tests in that section.

Aborting a Test Plan

Validate, Verify, Diagnose can be aborted if necessary
‘Ctrl’ ‘Break’
System will show a walkback error. Select ‘Abort’
From Cassini's ‘System’ menu, select ‘Reset’
Always do a system reset after aborting a test plan
Cals can be aborted, but only if absolutely needed
Cal data will be invalid
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Sometimes it may be necessary to abort a testplan. The reasons can vary, from missing 
a step specified in a condition statement, cal standards put in the wrong port, etc. All 
testplans can be aborted. Cal plans should only be aborted if absolutely necessary.

To abort a testplan, do a ‘control’ ‘break’. (hold ‘control key down, then hit the’break’ 
key). A ‘Walkback’ error will appear. Select ‘abort’. Then, in the ‘Programmer Message 
Window’ select ‘System’ ‘Reset’. (always do a system reset after aborting a testplan).
Most calibration plans reset the cal data when they compile, then insert new cal data 
when they run. If you abort a cal plan, or compile it but don’t run it, you probably have 
lost the old cal data.
Normally when you run a group of cals/validates through the calibration executive, when 
they are finished you will see a message that says ‘saving cal data’. However, if the 
‘validate’ fails, the cal data is not saved. If you want to save the cal data, it can be saved 
manually by doing an ‘RMBC’ on the active tester, then selecting ‘Save’.

If either of the above has occurred and the cal data has not been saved, you can still get 
the old cal data back by using SYSTEM button, Equip menu, Startup (takes about 30 
seconds).  This restarts the system, loading the lastest version of any object (including 
the valid calibration data) from guru, except reapplying patches.  

Special "Service Plan" buttons

Reset Cal factors
Write to Cal factors
Perform special calculations for calibration
Not available through normal editor
Do not copy or modify special buttons

Special Calibration Buttons are just that “Special”. Cal factors can be written to, and 
reset through these buttons. They also perform certain calculations for cal. Bottom line in 
regards to special Service Plan buttons, DO NOT TOUCH!!
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Troubleshooting - Limits in Service Plans
Revised: 07/25/2011 - 07/28/2017 Topic(s): Admin; Diagnostics Doc ID:RBEH-8K54NW  (2 pages)

Some issues involve inspecting the Limits set by the Calibration testplan.

Limits are set on data save buttons
To check limits:
‘Limits’ ‘Select’ ‘SystemCheck’
All limits for cal/service plans are called SystemCheck

Right Mouse Button Click (RMBC) on data save button
‘Single Value Limit’ (same as customer test plans)
NEVER CHANGE A CAL TEST PLAN!!!

All of the validate/verify/diagnose plans have limits. If the measured data exceeds the 
limit, the test fails.

Sometimes a diagnose/verify/validate will fail by a small amount. You will need to know 
the limit of the test, to know how far off the failure is.

To check the limits of a test plan, open the test plan and compile it. Select 'limits', 
'select', then ‘SystemCheck'. The limits for the calibration & service plans are all titled 
‘SystemCheck'. Right Mouse Button Click (RMBC) on the data save button and select 
'Single Value Limit'. This will display the limits for that measurement. To find the limits 
within a test plan, you first must find the data save button(s).

NEVER CHANGE A SERVICE TEST PLAN! Remember that you are a super-user and 
can change things that will cause the test system to malfunction.



Troubleshooting - Limits in Service Plans(Cassini Maintenance Manual - )

Page 107

This image shows the limits for Vcc1 in the ‘VCC 123456 Validation CF2’ test plan. As 
before, Right Mouse Button Click (RMBC) on the data save button, select, ‘Single Value 
Limit’.

The range for Vcc1 in this test plan is a minimum of -0.02V (-20 mV), and a maximum of 
0.02V (+20 mV).
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Troubleshooting - Visualizing Data (Graphs)
Revised: 07/25/2011 - 07/28/2017 Topic(s): Admin; Diagnostics Doc ID:RBEH-8K54TD  (2 pages)

Normally, it’s easier to interpret data as a graph, rather than a bunch of numbers. As 
such, one of the more powerful troubleshooting tools is the test system’s ability to graph 
data.

Many graph types are possible, but the 2 that are used 90% of the time are the 
rectangular graph and the moving strip chart.

Left click on Data Save or Local Variable button
Select graph type
Rectangular for arrayed data (Frequency Response data, etc.)

Moving strip chart for CW data
Moving strip chart can handle up to 500 measurements
If local variable, will need to format graph
Sort by ‘Index’, X value sort by ‘Index’

If a test does multiple data points in one data save button (for example, if the test does 
measurements at multiple frequencies), then the rectangular graph is used. If the test 
saves one point, then the test can be repeated, and the moving strip chart is used to 
check repeatability. The moving strip chart is particularly useful for ‘rattle’ tests, where 
you’re looking for things that change with mechanical movement, such as loose cables.

Note that you can graph local variables, as well as data saves. However, if you graph a 
local variable, the data will be pre-sorted in a manner that you probably don’t want. To 
view the data ‘as taken’ on a local variable, you need to tell the graph to sort by ‘Index’, 
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and to sort the X value by ‘Index’

Does this graph show good data or bad data ?

A word of caution about ‘Auto’ scale. It’s possible to take perfectly good data and make it 
look bad by selecting the ‘Auto’ button. This button will increase the scale until the data 
fills the screen. Note the Y SCALE on this graph is 0.002 dB/division.

Always be aware of the scale when viewing data as a graph. 
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Troubleshooting - Basic Diagnostic Process
Revised: 07/25/2011 - 07/28/2017 Topic(s): Admin; Diagnostics Doc ID:RBEH-8K555N  (2 pages)

Is the problem in the source path or receive path?1.
Does the problem 2.

Change with respect to frequency?
Change with respect to power?

Murphy’s corollary: There is always more than one problem3.
One problem can cause multiple failures4.

Be sure you’re looking for the right problem
Usually run all diagnostics

The list shows the basic thoughts to always keep in mind when troubleshooting the 
Cassini Test System.

The test system uses the sources to test the receiver, and visa-versa. When a test fails, 
you can immediately cut the problem in half by checking if the problem is in the source 
path or the receive path.

Also, does the problem change with respect to frequency (frequency response problem) 
or power (linearity problem)? 

Always remember, more often than not, “Murphy’s Corollary” applies. “There is always 
more than one problem”.

The inverse of that can also apply: sometimes one problem can cause multiple failure 
symptoms. This is why you want to run all the diagnostics, to find patterns in the failure 
symptoms that point to a specific problem.
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‘Normal’ Troubleshooting Tree

Run Diagnostics (all of them)
Review failed data
Look for patterns (only 1 port, direct receive path, etc.)
Pull up test plan
Re-name to ‘Junk’
Set breakpoint
Run to breakpoint
Open Controller
Manipulate settings through controller
Begin ‘halving’ signal path
Isolate bad component

Unfortunately, for RF, it’s not practical to insert test points wherever we feel like. So, to 
diagnose RF problems, you normally have to run all of the tests, then look for the 
patterns in the failures. For example, if a problem occurs at RF3, but not RF2, 6, or 7, 
then the problem must be in some area that’s unique to RF3. If the problem occurs at 
RF2, 3, 6, and 7, then the problem must be with something that’s common to all those 
ports.

Using this process of elimination, you can usually diagnose the problem to a couple of 
possibilities before you connect any test equipment.

Once you’ve done the heavy thinking to eliminate what it can’t be, then you can check 
for the remainder by manipulating a test plan to stop at specific points, and checking 
where the signal goes bad.

Remember, you are a super-user. As such, you have the power to render the test 
system totally inoperable. An easy way to ‘accidentally’ do this is to modify a test plan 
then save it.
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Troubleshooting - Common RF Scenario & Source Basics
Revised: 07/26/2011 - 07/28/2017 Topic(s): Admin; Diagnostics Doc ID:RBEH-8K5TKA  (3 pages)

This is a common scenario when troubleshooting a Cassini system.  During Cal, a 
validate fails, you troubleshoot the problem to a bad switch, you replace the switch, you 
run diagnostics, and now diagnostics fail. 

What’s wrong?  (Hint: It's probably a Source)

The source (a.k.a. synthesizer) contain as much circuitry as everything else in the test 
system combined. The fact that they are complex and that there are 4 or 5 of them in a 
system means the synthesizers are the most common failure item in a system.  We 
don’t expect you to become experts in the design of microwave synthesizers. However, 
a basic understanding of how the sources work and how they are used in the system 
will help you troubleshoot source problems and perhaps even repair sources on-site.  A 
synthesizer simultaneously achieves high resolution and low noise through a complex 
arrangement of phase lock loops. There are 4 loops in a synthesizer, as shown.

The YIG (Yttrium Iron Garnet) oscillator produces the actual output. It is able to be 
tuned from 2 GHz to 20 GHz. For frequencies below 2 GHz, the YIG oscillator is mixed 
with a fixed frequency oscillator in the Down-Converter to produce 10 MHz to 2 GHz.
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Common Source Failures

A3 Reference loop
Certain vintages
Time base ‘shifts’ after 1-3 years

Down Converter
Dead
Phase lock (frequency accuracy) problems
ALC (power control) problems

Source Basics

Startup Source Tests
Check all loops
Check ALC range
Single frequency test

Self Test (Control Panel)
Check all loops
Check ALC range
Multiple frequency test

There are many self-tests that help to diagnose source problems. The nature of 
synthesized sources is such that it is relatively easy to confirm all the loops are properly 
locked.

The software gives the sources a quick test whenever a system startup is performed. A 
more comprehensive test can be performed by running the self test in the control panel.

To run the self test, open the control panel, highlight the appropriate source, and select 
‘Instrument’ ‘Self Test’. The test system will run the self test and show the results in the 
programmer’s message window.

Source Troubleshooting Hints
Problem only below 2 GHz, likely a down converter
Different averages can help diagnose lock problems
Power meter can eliminate confusion from receiver issues (remember Murphy’s 
corollary)
Power correct can be turned off (but not all corrections are removed)

With the internal self-tests and your knowledge of sources, source problems are usually 
straight-forward to find.

One exception can be subtle phase lock problems, where the self test can’t detect the 
problem.

Averaging Can Find Phase Lock Errors

Changing averages can find source phase lock errors. This is because the average is a 
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vector average. If the source is not phase locked, its phase will be randomly changing 
with respect to the receiver. When averaged, the result will be a smaller amplitude.

In the diagnostics for each source, there is a phase lock test that performs this function.
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Calibration Issues - Restoring Fixture Calibration Data
Revised: 04/14/2011 - 07/28/2017 Topic(s): R&D; Software Doc ID:RBEH-8FWPEE  (3 pages)

The Guru system saves all previous revisions of all Guru objects ensuring that there is 
never a lost revision of anything. This can be invaluable with test objects (Test plans, 
Fixture definitions, etc), but Fixture, DIB and Instrument Calibrations are a special case 
and are managed differently. 

For guru objects, other than calibrations, refer to  Browsing, Importing, Exporting and 
Recovering Guru Objects document (take a look at the 'Recovering a Guru Object' 
subject).

To find out which object class you need to select, refer to RI Guru Object Classes 
document.

For calibration objects, the method is different. This is due to each calibration revision 
being saved as a separate guru object, as opposed to most object classes, where there 
is a single object with multiple revisions.

To revert to an earlier version of a calibration, the exercise is completed in the Tester 
configure window as opposed to the guru browser.

Open the tester configure window.

From the Tester Configure window, highlight the fixture (or DIB, or Instrument).
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With the desired object highlighted, select Instrument>Calibration> Restore.
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When the Confirm Dialog appears, select Yes.

Choose the Date of the desired revision of the Calibration.  Press Select.

Then Save it as the latest with Instrument>Calibration>Save.
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Advanced Troubleshooting - Opening a TIM
Revised: 07/29/2011 - 07/28/2017 Topic(s): R&D; Software Doc ID:RBEH-8K8NXP  (2 pages)

Normal Support procedures require that the TIM be shipped back to RI for repair.    
Contact support@roos.com for RMA and safe shipping instructions.

Under certain rare conditions, it may be appropriate for the TIM to be opened and 
serviced on-site.  All TIMs share the same case that can be easily opened for service 
and placed in use for diagnostics (attached to the Test Head) with the cover removed.  
DO NOT TOUCH any active electronics with the case removed without direct instruction 
from RI.  TIMs can be safely removed from the Test Head with the power on.  The 
software should be in an idle state (TestExec not running and no testplans loaded) and 
the Fixture should be removed prior to removing any TIMs.

To open/close the case:

Remove the top half of the Cassini TIM.   When placed on a table, The RI model/serial 
number label should be facing up.  When loaded on the left side of Test Head, the TIM 
port on the upper right side, the side to remove is facing you.
  

On the bottom latch, unscrew the 2 left screws 10-15 turns but do not remove the 1.
screws completely. There are 4 total, do not loosen or remove the inner pair of 
screws.

Unscrew the outer 2 right screws 10-15 turns but do not remove the screws 2.
completely. There are 4 total, do not loosen or remove the inner pair of screws.
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Orient the TIM so the text on the TIM label is upright. Unscrew the 8 side screws on 3.
both sides. (16 total)

Pull the bottom latch until the cover clears the EMI/RFI groove of end cover. Pull the 4.
cover up and away from the TIM. Note that some TIMs have EMI/RFI elastomer 
gasket in the groove. Use caution to ensure the elastomer does not come out.

ONLY If cables on the interface block need to be replaced.  Unscrew the top 2 screws, 
then the 2 screws on the side.
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Advanced Troubleshooting - Replacing TIM Fuse (5 Amp)
Revised: 07/21/2016 Topic(s): R&D; Software Doc ID:RBEH-AC3TZN  (2 pages)

Normal support procedures require that the TIM be shipped back to RI for repair.    
Contact support@roos.com for RMA and safe shipping instructions.

Under certain rare conditions, it may be appropriate for the TIM to be opened and 
serviced on-site.  All TIMs share the same case that can be easily opened for service 
and placed in use for diagnostics (attached to the Test Head) with the cover removed.  
DO NOT TOUCH any active electronics with the case removed without direct instruction 
from RI.  TIMs can be safely removed from the Test Head with the power on.  The 
software should be in an idle state (TestExec not running and no testplans loaded) and 
the Fixture should be removed prior to removing any TIMs.

IMPORTANT: The Fuse is soldered to the bottom of the Y00070X# board and so the 
bottom cover should be removed.  The top cover can be left in place.

Required Equipment:
GF1SZ12A, Fuse 5A smt 1206  (markings: white with grey 5 on back, green on front)
Soldering Iron, Flux, Solder, Solder Cleaner
#2 Philips Screwdriver

To open/close the case:

Remove the bottom half of the Cassini TIM.   When placed on a table, The RI 
model/serial number label should be facing down.  When loaded on the left side of Test 
Head, the TIM port on the upper right side, the side to remove is facing AWAY from 
you.
  

On the bottom latch, unscrew the 2 left screws 10-15 turns but 1.
do not remove the screws completely. There are 4 total, do not loosen or remove 
the inner pair of screws.

Unscrew the outer 2 right screws 10-15 turns but do not 2.
remove the screws completely. There are 4 total, do not loosen or remove the inner 
pair of screws.
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Orient the TIM so the text on the TIM label is upside down. Unscrew the 8 side 3.
screws on both sides. (16 total)
NOTE: Picture shows the TOP being removed, DO NOT REMOVE THE TOP!

Pull the bottom latch until the cover clears the EMI/RFI groove of end cover. Pull the 4.
cover up and away from the TIM. Note that some TIMs have EMI/RFI elastomer 
gasket in the groove. Use caution to ensure the elastomer does not come out.
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Identify the F1 location on the board and remove the damaged Fuse.  Solder the 5.
green side facing up.
NOTE: Picture shows the fuze installed upside down.
  

After replacing fuse, replace the cover and tighten all screws.  Verify functionality by 6.
latching TIM to Cassini Testhead and perform a System > Check.  Run TIM specific 
diagnostics.
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Advanced Troubleshooting - Cassini 16 Infrastructure (RI8568B)
Revised: 07/12/2012 - 01/04/2017 Topic(s): Admin; Diagnostics Doc ID:RBEH-8W5NLM  (4 pages)

The Cassini 16 Infrastructure provides 3 service panels to access the conditioned power 
supply modules, RIFL hub (communication and shared 10 MHz clock), Front and Rear 
RIFL Top boards, pneumatic Fixture locking and mechanical foundation for the System 
Controller (EPC) and all 16 Cassini TIMS in the Test Head.  Contact Support 
(support@roos.com) for specific instructions for diagnosing or replacing malfunctioning 
items.

Tools Needed:  
#1 Philips (All Panels) -AND/OR- M4 Allen Wrench (Mainframe Service Panel).  Replace 
power supply with #2/3 Philips.

 

Electrical Shock Hazards

There are NO electrical shock hazards from any of the exposed electrical connections 
on the test head or on any surface of the system.  The system uses 48 volts or less and 
shock hazards are typically designated as to 50 volts or higher

3
.  No high-voltage cables 

or connections are exposed at any time during operations or when moving the system.  
Fixtures and Tester Instrument Modules (TIMs) can be safely removed "hot" without 
disconnecting power without damaging the equipment or exposing live connections to 
the operator.  The system is equipped with an Emergency Off (EMO) button that 
instantly disables all 48 volt connections. 

The "Main Breaker" is used to disconnect all electrical connections and should be 
switched "Off" before performing any infrastructure maintenance that requires tools to 
remove protective metal covers.  The side breakers labeled "TIM Front", "TIM Rear", 
"Head" or "Mainframe" can be switched "Off" before opening specific service panels.
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Test Head Service Panel

IMPORTANT Switch the "TIM Front" & "TIM Rear" (RevA) or "Head" (RevB) side 
breakers to OFF before opening the Test Head service panel.

The Test Head service panel can be opened to access the RIFL board, Test Head fans, 
control board, power distribution and other components in the Test Head.

The diagram below shows the 16 screw locations needed to remove the access panels 
for either the Test Head or Front panel, 3 on the back, 12 on the top, and 3 on the front.  
Remove ALL TIMs and rotate the top of the Test Head away (as pictured).
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Power Supply Module Service Panel

IMPORTANT Switch the "Main Breaker" to OFF before opening the Power Supply 
Module service panel.

The hot-swappable two redundant 48V 800W 16.7A power supplies (RI PN 
GR1PWF2A) can be independently replaced if either AC Good or DC Good green lights 
are OFF.  Before swapping, remove the single retaining screw with a #3 Philips Screw.
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Mainframe Service Panel

IMPORTANT Switch the "Mainframe" side breaker to OFF before opening the 
Mainframe service panel.  

Unscrew the 6 Philips head screws and 2 Allen head screws and AUX mount plate from 
the front of the panel.  Slide the panel away from the tower by pressing firmly on the 
front and pushing outward as seen in View A and the zoomed View A diagrams.
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Advanced Troubleshooting - Repairing RI8546 Device Power TIM
Revised: 07/15/2013 - 07/28/2017 Topic(s): Diagnostics; Manufacturing Doc ID:RBEH-99MU56  (2 pages)

Follow these instructions ONLY when directed by ROOS Support .  Replacement internal  
module must be available .

To repair the RI8546 Device Power Module (DP,VM,DB,VI,VCC):

Remove any Fixture that may be attached, and remove TIM.  (System Shutdown NOT 1.
necessary)

Remove top cover.  (See Opening a TIM)2.

Locate the damaged modules by comparing to picture of locations below. (i.e. VCC 3/4 & 3.
DP1-8)

Replace with spare parts.  MAKE sure that the modules are installed with the correct 4.
orientation and are pressed all the way into their sockets.

Replace cover, insert TIM back into the Testhead and preform a "System Check".5.

Let TIM warm up for 20 Minutes.6.

If Instrument names are not default, rename (optional)7.

Calibrate replaced "Instrument": 8.

Example: replace VCC 3/4 & DP1-8

In the Tester Configuration window find and highlight RI7421B dut control1.
Right mouse button click and select Rename.
Rename the RI7421B "dut control1" to just "dut control" (remove the trailing 1)

Run the following calibration plans from the calibration window.
RI7421B VCC 3-4 Calibration CF2
RI7421B VCC 3-4 Validation CF2

(Optional) Rename the RI7421B "dut control" BACK to "dut control1" from the Tester 
Configuration window.

Run targeted diagnostic procedure.9.

Verify operation by testing with a known good part.  If passes, release to production.10.
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Support - Sending Data and Getting Assistance from Roos
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8FWRJR  (2 pages)

Getting support from Roos Instruments is easy.  Please follow the 
troubleshooting guide, generate and export any relevant data, and send to 
ROOS.

Email "support@roos.com", 24 hours a day, 7 days a week.  Reply 1.
during normal business hours.

Call +1-408-748-8589 M-F 9am-7pm Pacific Standard Time (-8 GMT) 2.
to talk with Roos Engineers

Visit "roos.com/support" to access documentation and review 3.
software updates

Sending Data to Roos Instruments

Often RI Support can be of more help if the testplan or data is included in the service 
request.

If a "Walkback" window appears, press "Save" and send us the "vRtError.log" or 
"walkback.log" file located in the program directory, d:\RiApps\GuruApps\######## ( 
App number, Cassini = GF10RC2A ).  The App Number can be found from the Help | 
About menu.

TIP!   vRtError.log is a txt file, if running from a simulator, use the clipboard to cut & 
paste into email.

To send us the Guru objects needed to recreate the issue, follow the instructions to 
Export a Simulation.

Export Simulation for Cassini

To send us information, use Guru Browser to export a “.gzp” (Pronounced "G-Zip") of 
the instrument's cal data.

Example Key Selection:
ri.sys.ObjClass = RiInstrumentCal
ri.hw.Model = <Instrument Model Number>
Select the desired object, right click, select “Export | Guru Format" 
Save to mounted network drive or USB stick (or use web mail) and email to 
support@roos.com

REQUIRED:
RiShortcut – Cassini System Software Management Shortcuts
RiTesterDef – Cassini Instrument Collection Definitions
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Other important ObjClasses: 
Depending on where the error occurred, these other objects could be needed.

RiBaseInstDef – Instrument Feature Definitions
RiCalibrationKit – Calibration Offsets
RiCalList – Calibration Test Plans
RiEquipDiagLog – Diagnostic Logs  (From the diagnostic testplan results, select “Results 
| Save to Guru”)
RiFixtureDef – Fixture Definitions
RiFixtureCal – Fixture Calibrations
RiInstrumentDef – Instrument System Drivers
RiInstrumentCal – Instrument Calibrations
RiPatch – Cassini System Software Updates
RiShortcut – Cassini System Software Management Shortcuts
RiTesterDef – Cassini Instrument Collection Definitions
RiTestplan - Testplans (includes Developed (DUTs) and Service: Calibrate & Validate, 
Diagnose & Verify)
RiTestExec - Package Executive (runtime settings for Test Plans including handler and 
Datalog info)

Sometimes files must be saved as text (.txt) files. Always zip a file before sending it. Zip 
the file to ensure it will survive email. 

From the command prompt: 
cd d:/folder/name/
zip ‘zip file name’ ‘name of file(s) to be zipped’
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Exchanging TIMs (Cassini Test Instrument Modules)
Revised: 07/25/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8K5525 (1 Page)

Cassini Test Instrument Modules (TIMs) can be easily removed while the system is 
powered without causing damage.  If a Fixture is attached, remove the Fixture before 
removing a TIM.  Before installing a new or factory returned TIM, make sure the 
software definition and calibration data is loaded into Guru.  Import the ".GZP" with Guru 
Browser on any other Guru client connected to the same Guru Server or onto the local 
Guru on the test system BEFORE inserting the TIM.  Note: No software needs to be 
loaded if the TIM is moved to another Cassini or to a different location on the Testhead.

NOTICE!  Wait for the TIM to warm up at least 20 minutes before running tests or 2 
hours before running Calibration or Diagnostics.

Simply pull the handle at the top of the TIM to power it down and prepare it for removal.  
Remove the module by securely grabbing the module's side, then pulling the lower 
handle to release it from the Test Head.  After removing the TIM, from the Cassini 
application, use the System | Check button to force the system to identify and use any 
hardware changes.

TIMs can be just as easily docked to the Testhead by sliding the module up into the slot 
until you hear it click.  Then push in the top handle to power up the modules.

The system may take up to 20 seconds before the new module is detected and can be 
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used by the system.   From the Cassini application, use the System | Check button to 
force the system to identify and use any hardware changes.
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Export Simulation for Cassini
Revised: 02/25/2016 - 03/10/2017 Topic(s): Admin Doc ID:RBEH-A7GU2E 

A simulation allows Guru Browser to export all relevant guru objects helpful for 
debugging an issue or transferring content by creating a RiSimulationDef object.  A 
simulation does NOT include the ShortCut used to initialize the Cassini software.  If the 
ShortCut was created on site and not by RI, it should also be exported and included in 
the email to support@roos.com.  This simulator should not be confused with the RI 
Cassini Virtual Workstation that is sometimes referred to as "the simulator."

To export a simulation:
Compile a testplan with all the software definitions active (Fixture def, DIB def, 1.
Fixture calibration, Device def, etc).  If the problem is encountered when running a 
Test Exec, open the Testplan referenced by the Exec.
From the Cassini main system window, choose System > Equip > Save Sim. 2.

Then open Guru browser and change Key1 value for ri.sys.ObjClass to 3.
'RISimulationDef' to show all Simulators.
From the list click the 'ri.sys.CreationDate' column header to sort by date and select 4.
the item that was just created. 
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Export that file to a GZP by choosing Export > Send to Export List from the menu. 5.
Switch to the Guru Export List tab by selecting it on the bottom of the window, and 6.
then export the file to "D:\support" or similar directory.
Send that .GZP file to support@roos.com for review, be sure to note the ShortCut 7.
name that was used when the problem was encountered.
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Exchanging Cassini 16 System Controller
Revised: 04/14/2011 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8FWRJS  (3 pages)

Updated instructions:

Subject Category Modified

System Controller Exchange (EPC TIM) Training
System Controller
System Software
EPC

01/20/2016  contains illustrations

  Previous Instructions
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Packing and Shipping a Cassini TIM
Revised: 04/29/2013 - 07/28/2017 Topic(s): Admin; Manufacturing Doc ID:RBEH-7WURDD  (2 pages)

DO NOT DISCARD
REUSE THIS BOX 
Proper packaging of the ROOS Test Instrument Module (TIM) will prevent damage and 
improve response time for your replacement.  Please follow the Return Instructions to be 
issued a RMA number to place on the outside of the box.  Due to the large amount of shock 
experienced during shipping and the thin, flat nature of TIMs, each TIM should be individually 
boxed with the original foam packaging it arrived in. You should return a TIM in the original 
packaging or using your own packaging.  

Note: The Infrastructure TIMs (Source) must be shipped using "Packaging Instructions for 20 
GHz Synthesizers" because they are so heavy.

TIM Packaging

Open box so TIM "head" (notch) is facing to the left.  Two screws should be visible from 1.
the TOP.  Make sure foam padding is below and around TIM.

 

Place foam padding on TOP of TIM and close box2.
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Your Own Packaging

Use a box of at least 26 in x 20 in x 8 in (66 cm x 51 cm x 20 cm) outside dimensions.

Securely pack with at least 3 inches ( 7 cm ) of compressible polyethylene foam packing or 
bubble wrap around all surfaces of the TIM.   

Additional packing instructions can be found on-line.  UPS: How to Prepare for Shipment

You can contact support@roos.com if you have any questions.  You may reorder original 
packing materials directly from Roos Instruments.
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Exchanging AUX Rack Source TIM

Revised: 03/30/2012 - 07/28/2017 Topic(s): Admin Doc ID:RBEH-8SW447  (2 pages)

Cassini AUX Source Module Exchange

Cassini's AUX rack source TIMs (including Receiver LO) can be easily removed while 
the system is powered without causing damage.  If a Fixture is attached, remove the 
Fixture before removing a Source.  Since there are no rack trays, all sources above the 
damaged source should also be removed.  In other words, if the bottom source needs to 
be replaced, completely detach, unscrew and remove all sources above that one.  

ATTENTION: Always keep the RIFL and RF cables in the same order from top to 
bottom, this is how the system identifies the resources.  Again, if you are removing more 
than one Source TIM, you must connect the RIFL and RF cables to the same sources!

Before replacing the source, load the calibration data (.GZP file) into Guru with the 
"Guru Browser" application.  This can be done from any system, so long as the Guru 
server is properly configured.
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From the back of the rack, open the access 
panel and power down the Source by 
switching the power OFF and removing the 
AC cable, then remove the RIFL cable, and 
carefully remove the RF SMA cables.  
Always turn the coupling nut, do NOT spin 
the center conductor.  Do not twist the 
cable.  Do not try to put a wrench on the 
gold tip cap.  Unscrew the front rack 
mounting screws with a #1 Phillips head 
screwdriver and carefully slide the source 
out.  Replace the sources by following these 
instruction in reverse (but keep the vertical 
order of the sources the same!)

WARNING: The source is very heavy (26 Kg), so please be very careful in moving and 
shipping.  
 
After removing a source, DO NOT press "SYSTEM | CHECK" buttons until AFTER the 
new source is installed.  The software will attempt to identify the new source as the 
same as the last removed one.  If multiple sources were removed, be sure to reattach 
ALL sources before pressing SYSTEM | CHECK.

Verify the source identities are correct by opening the tester viewer by pressing 
SYSTEM | TESTER.  Identify the newly added source from the list and select "Flash 
LED" from the right mouse button menu.  The system will be unresponsive for 10 
seconds while the LED flashes GREEN-RED.

If the source WAS identified correctly, save the tester definition by selecting "Save" from 
the "Tester" system menu.  This will permanently assign the resource and prepare the 
system for future source replacements.

If the procedure above was not followed correctly (i.e. sources were swapped without 
saving) and the source was NOT identified correctly, select the desired source identity 
(i.e. "RecLO") and change the name by selecting "Rename" from the right mouse button 
menu to a temporary name like "SOURCE A".  Now use the "Flash LED" procedure on 
the incorrectly identified new source and then select the "Rename" option from the right 
mouse button menu and name it correctly ("RecLO").  Note: Case sensitive names.  
Now rename the temporary "SOURCE A" resource as it's correct name (RF and RIFL 
cables are labeled). Verify with the "Flash LED" procedure and then save the tester 
definition by selecting "Save" from the "Tester" system menu.

Run system diagnostics to verify the new source calibration data is loaded properly.   If 
the RecLO was swapped, a system calibration is NOT NEEDED.  The RecLO is not 
sensitive to source variation and is the ONLY resource that can be replaced without a 
system calibration.  If any other sources have been changed, a complete system 
calibration is required.  

The system is now fully functional and online.

Return the damaged Source following the RF Source Packing Instructions.
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Shipping AUX Rack Source TIM
Revised: 08/22/2012 - 07/28/2017 Topic(s): Manufacturing Doc ID:RBEH-4MDP9R  (2 pages)

The RI7710 synthesizer (aka Source) is typically the largest, heaviest and most delicate 
instrument in an RI system. As such, special care must be used when packaging one for 
shipment. This document defines packaging instructions when preparing an RI7710 synthesizer 
for shipping.

If at all possible, the synthesizer should be packaged in a Roos approved Anritsu (OEM) 
shipping box. If shipping from North America, Roos Instruments will forward a box to you at your 
request. When properly packaged in an Anritsu box, the synthesizer is sandwiched between two 
plastic sheets. The plastic sheets suspend the synthesizer in the middle of the box and provide 
cushion against shock.

To package in an Anritsu box, first wrap the synthesizer in the foam provided, being sure to 
cover the sharp edges at the corners of the synthesizer. Wrap this assembly in the plastic 
provided and tape the plastic closed. Place this assembly in the box between the plastic sheets.

Note that the Anritsu box has a diagram on the flap that shows the proper placement of the 
synthesizer within the box. When using an Anritsu box, be sure to follow the diagram precisely 
to prevent damage to the synthesizer in shipping.

If an Anritsu shipping box is not available, the synthesizer may be packaged in an appropriate 
shipping container. Minimum requirements for the shipping container are double-wall cardboard 
with an approved weight limit of at least 100 lb. (220 kg). To package the synthesizer, use either 
soft foam or bubble wrap. Do NOT use Styrofoam beads (popcorn) as they can shift during 
transit and permit the synthesizer to move in the package. The minimum packing material 
requirements are as follows:

Top, bottom: 4" (10 cm)
Sides: 5" (12.5 cm) from side, 4" (10 cm) from rack mount ear protrusion
Rear: 5" (12.5 cm) from rear face, 4" (10 cm) from rack mount protrusion
Front: 6" (15 cm) from front face, 4" (10 cm) from handle protrusion

Note: NEVER pack more than one synthesizer per box . ALWAYS use a separate box for each  
synthesizer.

The following synthesizer information is provided to assist you in determining an appropriate 
size shipping container for the synthesizer

Dimensions, L x W x H: 26" x 19" x 5.25" (66 cm x 48 cm x 13.5 cm)
Net Weight: Approx. 50 lb. (110 kg)
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Minimum Package Size: 34" x 27" x 14" (86 cm x 69 cm x 36 cm)

The cost to repair a synthesizer that has been damaged in shipping falls on you, the customer. It 
benefits both you and Roos Instruments to package the synthesizers well when shipping. When 
properly packaged, the synthesizer should arrive safely, preventing damage and saving cost.
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Shipping a Cassini Fixture
Revised: 05/03/2011 - 07/28/2017 Topic(s): Admin; Manufacturing Doc ID:RBEH-8GJ3S5 (1 Page)

In preparation to shipping the fixture the following steps should be noted.

Wrap the fixture in two or more layers of anti-static bubble material. The bubbles should have a 1.
diameter of no less than 0.8 inches (2 cm). Styrofoam should not be used to protect pins during 
this process as it is a generator of static. Anti-static foam is OK.

The box used should allow for at least 3"of isolation between the fixture and box (not including 2.
the thickness of the bubble wrap).  As a general rule, use a box with the following specifications:

Single Wall Corrugated
Bursting Test 200 lb/sq. inch
Min Comb WT Facings 84 lbs per m sq ft.
Size Limit 75 inches
Gross Weight Limit 65 lbs
Min Dimensions 20"x20"x12"

Place the wrapped fixture into the box and finish filling it with shipping material and then seal it 3.
well.  Label the outside of the box "FRAGILE" or "DELICATE INSTRUMENTS" or similar.
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Preparing a Cassini 16 System for Shipping
Revised: 02/15/2011 - 08/02/2017 Topic(s): Admin; Manufacturing Doc ID:JWAD-8E4UDE  (2 pages)

The Cassini 16 Infrastructure and TIMs should be shipped in a RI provided crate and packing material.  
Protect any Remote TIMs in bubble wrap and then wrapping the AUX Rack assembly in shrink wrap.  Also, if 
an AUX Rack table is attached, it may have to get removed before wrapping up the AUX rack.  The front of 
the AUX rack faces left in the crate and the shelf can be attached if it fits under the Testhead in the crate, only 
if it is installed on the left side of the AUX rack.  On a system with more than 10 TIMs, the table will prevent 
TIM boxes from be inserted under the Testhead, so it may have to be removed anyway to fit all the TIMs in 
the crate.  The 5x TIM box uses the standard TIM foam inserts in between each TIM (up to 5), but is 
equivalent to 4 standard TIM boxes in height.  Securing the Testhead when loading the tester into the crate 
also requires special attention and requires a custom power adapter and extension cord after loading into the 
crate.  Also, please make sure appropriate shipping arrangements for any Fixtures on site, see Shipping a 
Cassini Fixture.  Please return all tools to RI by including them in the crate and then after unpacking, return 
the items in the 5x TIM box (with supplied TIM foam).

Equipment Needed:
Cassini 16 Crate (made with Nematode-Free wood), Shipping Weight: 750-850 lbs. (385 Kg) - 
W1MFFHHB
Plastic Bag marked "Tester" (to cover whole infrastructure)
AUX Rack Strap (only if short AUX rack)
Bubble Wrap and protective foam for AUX Rack Remote TIMs
Foam pad(s) for AUX Rack/Testhead
Extra Foam Blocks, Foam Sheets (for stability) for securing boxes in crate
QTY ____ 5x TIM Box (5 TIMs loaded in one box, standard foam packing material, 5x TIM anti-static 
bags)
QTY ____ 1x TIM Box (with standard foam packing material, TIM anti-static bag)
Box for Handler POD and cables
QTY1 Box for Monitor with 1" packing foam, QTY 1 Box for Keyboard/Mouse/Network cables 
(optional - workstation)
Foam pad(s) for Production Touchscreen Arm (optional - production)
Box for Testhead counterweights (optional)
3x Metal Straps for securing crate (optional - International Shipments ONLY)

Tools Needed:
Box Tape & Tape Gun
Shrink wrap plastic Roll & Dispenser
Power Cord Adapter (Custom made NEMA 20 to NEMA 15)
Extension Cord (NEMA 15, standard US)
7/32 Allen Wrench (optional - for removing Test Head counter weights)
Metal Band crimp and cutting tools (optional - International Shipments ONLY) 

Documents:
This "Preparing a Cassini 16 System for Shipping" document.
Unpack Instructions in shipping envelope (to attach to outside of crate)
Testhead TIM Block Labels for Interface plate (if needed)
Laminated Testhead Diagram (if needed)
TIM T-Location Labels (if needed)
List of Items to Return to RI
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Cassini 16 Infrastructure can be shipped by following these instructions:

Prepare the correct number of 5x TIM and 1x TIM boxes depending on the number of TIMs in the 1.
system, including the EPC TIM.  The RI8545 or RI8565 20 GHs 4 Port Testhead TIMs and RI8574 
EPC TIM require 1x TIM box because of it's 1.5x width, all other TIMs can be placed in any box size.  
Prepare any additional boxes as needed to safely transport Monitor, Keyboard/Mouse, Handler 
POD, cables, etc.

Undock from Handler/Pober and remove Fixture.  (See Shipping a Cassini Fixture)  Place Handler 2.
POD, RIFL Cable and Handler Cable in a box.

Identify the TIM locations and Attach T-Location stickers if not already labeled.  Remove all TIMs 3.
from the Test Head and place each TIM in anti-static bag and secure packaging provided by RI. (1" 
foam on all sides).
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If an Auxillary Rack is attached, disconnect the "aux" TIMs and rack leaving all instruments 4.
connected in the Aux rack.  Wrap the Auxillary TIMs in protective material (shrink wrap) and place on 
top of the Aux rack until ready for packing.  Depending on the location, it may be necessary to 
Remove AUX Rack shelf if it is included.  When placing in the crate, pack TIMs along the side of the 
rack under the shelf.

VIDEO INSTRUCTIONS: 

https://youtu.be/XN_NZOQLJiM

Prepare the Diagnostic Kit with Interface place and all necessary cables and adapters (contact 5.
support@roos.com for details).  Attach provided Testhead stickers if needed.  (Both Diag and 
Calibration Kit will be required on the receiving end.)
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Adjust Test Head arm about half way up, rotate and lock the Test Head position facing down (180 6.
degrees).

(OPTIONAL) Remove any Test Head counter weights and position counterweight arm to it's shortest 7.
position. Use two people and 7/32 Allen wrench to safely remove counterweights.
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Position the Test Head in "Maint Locked Position" position and pull the plug "up" to lock position.8.

Locked
Shutdown the System Controller following standard shutdown procedures and switch the system 9.
power OFF.  

If "Development Workstation" display option is used, disconnect all cables from the system controller 10.
including Monitor, mouse/keyboard, and network.  Secure Monitor in a safe box, remove base if 
applicable.  Place keyboard and mouse into any suitable box.  If the "Production Touchscreen" 
option is used, Do NOT disconnect any cables.  Carefully position the monitor arm and secure with 
Foam and plastic wrap.

Remove the EPC TIM, put in anti-static TIM bag and place in 1x TIM Box.11.

Disconnect the Power Cable from wall, leave all power distribution switches and the Main Breaker 12.
ON.  Secure Handler Ground cable to the Infrastructure with some plastic wrap (do not use box tape 
on the Infrastructure).

Prepare a wooden crate to RI specifications. (contact support@roos.com for details W1MFFHHB)  13.
Power must be available to adjust the Test Head once the system is loaded into the crate.  Open the 
hinged crate door by unlatching and lowering door to create a ramp.  DO NOT Disassemble sides of 
crate.
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Load Auxiliary Rack into the crate first, secure with foam blocks. Hook AUX Rack strap into eye bolts 14.
(see step 15) and strap down so it's snug.  Place a sheet of foam above the AUX rack.

Load Infrastructure into crate by using the handles, do not put pressure on the Test Head arm or 15.
blue ball.

Stabilize the Test Head by reattaching power, moving the power switch to ON, and lower the Test 16.
Head arm to rest on the protective foam divider by pressing DOWN to compress about 1/4 of foam 
thickness.  The infrastructure should not wobble.  If the AUX Rack is not present, use wooden 
spacer.

Lower Feet (screw all the way down) to secure the Cassini 16.17.

Load Diagnostic Kit, TIM Boxes, and accessory Boxes around the Infrastructure.  5x TIM box can be 18.
safely placed on top of arm.  Be sure to include any RI provided packing tools to Return to RI.
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Secure Large Bag around the TOP of the Infrastructure if it was not already bagged.  A broomstick 19.
can be helpful for pushing the far corner of the bag around the system.

Place the wooden block and tighten with wing nuts across the top of the Cassini 16 handles.  The 20.
infrastructure should now be secure in the crate.

Close the crate door, secure the 6 door latches.  Attach Unpack Instructions to the outside of the 21.
crate along with Packing List/Shipping Documents.  (International shipments require metal bands to 
be strapped around the crate.)

If not packed in the crate, please return ship all supplied tools supplied (labeled with "Property of RI") 22.
to "Roos Instruments, 2285 Martin Ave. Santa Clara, CA 95050 USA".
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Items to Return to RI after Shipping Cassini16
Revised: 01/04/2016 - 07/28/2017 Topic(s): Admin; Manufacturing Doc ID:RBEH-A5UW3J  (2 pages)

The Cassini 16 Infrastructure and TIMs should be shipped in a RI provided crate and packing material.   See 
Preparing a Cassini 16 for Shipping for detailed instructions.

Place all the items listed below into the 5x TIM box and return to Roos Instruments, 2285 Martin Ave, Santa 
Clara, CA 95050 USA.

RETURN THE FOLLOWING ITEMS TO RI
Items To Return:

5x TIM Box (5 TIMs loaded in one box, standard foam packing material)
Box Tape & Tape Gun
Shrinkwrap plastic roll & Dispenser
AUX Rack Strap
Power Cord Adapter (Custom made NEMA 20 to NEMA 15)
Extension Cord (NEMA 15, standard US) (optional)
7/32 Allen Wrench (optional- removing Test Head counter weights)
Metal Band crimp and cutting tools (optional - International Shipments ONLY) 

Some items are marked with labels: 
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Ship Large Cassini (RI8556A) System with a Crate
Revised: 06/12/2009 - 05/16/2017 Topic(s): Admin; Manufacturing Doc ID:RBEH-7SXRX5 

These instructions will help prepare the Large Cassini (RI8556A) Infrastructure for shipment.  Keep 
Monitor, Keyboard, Mouse, Handler POD and cables ON-SITE, DO NOT return with shipment.  Note: All 
pics can be downloaded here: 
https://drive.google.com/file/d/0B_8v0C62VWTrVTJBTnJvYlZCTlk/view?usp=sharing

For maximum Weight and Dimensions, see Site Preparation Guidelines for RI7100A, RI7100C and 
CASSINI. 

Prepare crate for ground or air shipment, photos and drawings of the crate needed for the Cassini test 
system. 

LargeCassiniCrate_export.pdfLargeCassiniCrate_export.pdf

IMG_4637.jpgIMG_4638.jpg

Tools Required
Crate for Large Cassini (see above)
5mm Allen (for Testhead removal and to raise stability foot)

Packing Instructions

If applicable, detach the handler and remove all connections to the handler including Handler Pod 1.
and grounding cable.

Unlatch Fixture (See Fixture Care, Maintenance and Shipping)2.

Properly power down Cassini (close RI System Software, Shut Down operating system and then turn 3.
power switch to OFF position)

DSC00253.JPG

Disconnect main power cable and green grounding wire wrap inside the rack.4.

IMG_4593.JPG

Remove the TIMS from the testhead and pack securely, any infrastructure TIMs can be left installed.  5.
(See Maintenance - Exchanging Cassini Modules) 
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TIMs.jpg

Raise anti-tip infrastructure feet a few inches to allow easy loading into crate. (4mm Allen)6.

 DSC01188.JPG

Remote the testhead from the arm with 4 screws closest to the arm and secure to rack.  (See pics)  7.
Raise arm to highest location.  Blue tape uysed for alignment is not required.

IMG_4626.JPG Unpack2.jpg IMG_4625.jpgIMG_4624.jpg IMG_4622.JPG IMG_4621.jpgIMG_4627.jpg

Wrap system with plastic. (See pics below)8.

IMG_4635.jpgIMG_4634.jpgIMG_4633.jpgIMG_4632.jpgIMG_4631.jpgIMG_4636.jpg

Load tester into crate then use lift bar to secure in crate.   After loading infrastructure into crate, 9.
place any TIMs in open spaces.

UNPACK 1.jpgDSC00178.JPG
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End of Life: Decommissioning of Cassini Systems
Revised: 04/18/2011 - 07/28/2017 Topic(s): Admin; Manufacturing Doc ID:RBEH-8G34WZ (1 Page)

Roos Instruments gladly accepts decommissioned Cassini systems for recycling at the factory.  Please do 
not discard RI ATE systems in landfill, the electrical components may contain lead.  Please contact 
support@roos.com for a RMA number and to arrange shipment, shipping costs are not paid.

The Cassini system and Test Instrument Modules should be returned in a shipping crate according to RI 
standards.

The system controller may retain sensitive production data.  The hard drive should be removed and 
destroyed to guarantee that no information is retained.  Once detached from the infrastructure, the system 
controller can be opened and hard drive removed with a standard #2 Philips head screwdriver.  Please 
contact "support@roos.com" for instructions for removing sensitive data without disabling the core 
functionality.

Shipping Address:
Roos Instruments
2285 Martin Ave
Santa Clara, CA 95050
United States

Contact Information:
support@roos.com
408-748-8589


